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Overview
The Windows help system is a powerful on-line aid not unlike a magic book which always opens itself to 
the exact page to which you need to refer.

Upon installing Astrology for Windows, this entire manual is available on your hard disk in a hypertext 
file (ast4win.hlp) allowing instantaneous jumps from any topic to any other related or unrelated topic.

You can print selected topics by choosing File and Print from the Windows Help toolbar menu.    The 
more advanced AstrolDeluxe for Windows program comes with a 180-page illustrated manual.



Help on Help
If you are new to Windows, or if you are unfamiliar with the Windows Help system, you should know that 
your computer already has a complete help manual on using the help system which you received when 
you installed Windows.    You can access this information by clicking on the Help menu at the top of the 
Natal Information Screen.    When the menu selections drop down, click on Using Help.    You will be 
given complete instructions on using Windows help files.

It is worth spending some time exploring this information even if you consider yourself an experienced 
Windows user.    Some of the topics covered are:    annotating the help topics with your own marginal 
notes, attaching bookmarks to frequently consulted topics to allow yourself even faster and easier access,
browsing through help files in "book order", printing a help topic, resizing and moving the help window, 
making keyword searches, and accessing other help files by use of the help program's File menu.

If this manual uses any Windows terms with which you are not familiar, click on Help, How to Use Help, 
and select the Glossary button.    Here you can find the definition of Windows terms such as double-click 
or minimize.    To return, click on Back.



The Help Menu
Most forms and windows in the program have a Help menu selection.    The Help menu on the Natal 
Information Screen is typical.    Clicking on the Help menu will reveal a drop down menu list of Help 
topics:

Using Help - As mentioned in Help on Help, calls up the Windows help file on the Help system.

Natal Information Screen - Calls up the topic which corresponds to the chapter "Natal Information 
Screen" in the manual.

Index - Calls up a list of topics covered which can be accessed by clicking on the green topic title.

AstrolDeluxe for Windows Demo - Runs the program which demonstrates the additional features of
AstrolDeluxe for Windows.

About Astrology for Windows - Displays an "About Box" giving copyright information about the 
program.



The Help Button
Some forms or windows have a Help button instead of, or in addition to, the Help menu selection.    The 
Help button will usually take you to a help topic which pertains to the particular task that the current 
window or form accomplishes.    If you desire, you can jump to other topics once in the help file.



Context Sensitive Help
At any time while using Astrology for Windows, if you press the F1 key, you will be presented with a 
help topic pertaining to your current activity in the program.    For example, if, while you are filling out the 
Natal Information Screen, you pause with the cursor inside the Hours Difference from Greenwich box,
unsure what is being asked for, you can press F1 and you will be shown a topic covering how to respond 
at that point.    Of course, you can also search the index or jump to other topics once in the Help file.



What You Will Need
To use Astrology for Windows, you will need the following:

An IBM type personal computer with 4MB RAM;

· Microsoft Windows release 3.1, 95, 98, NT or later;

· Graphics capable printer for hard copy output.

Recommended, but not essential, is the following:

· VGA or Super VGA Display;

· Laser or ink jet printer for professional looking charts and reports.

Related Topics:
To Install Astrology for Windows



To Install Astrology for Windows
Astrology for Windows will be distributed in two ways: A) directly from Halloran Software on a 3-1/2" 
diskette in which most files will compressed into a single WinZip self-extracting executable archive file; 
and B) through shareware in which all files are compressed together in a single self-extracting archive or 
zip file ASTWIN23.EXE. or ASTWIN23.ZIP.    Depending on how you received the program, follow the 
steps in sections A) or B).

A)

1. Place the installation disk in the floppy disk drive.

2. From the Windows 3.1 Program Manager, select the File menu.    Or, in Windows 95/98, click on 
Start or press Ctrl-Esc.    From the resulting menu, choose Run.

3. When the dialog box appears, type a:install or b:install depending on the drive in which you 
place the diskette.

4. Click OK.    After several seconds initializing, the WinZip screen will appear, showing the 
suggested c:\winastro path.    Normally you will click on the button Unzip to accept this path.    Or
alternately you could change the c: to d:, e:, f:, etc.    Do not delete \winastro as you do not want 
to install to any drive's root directory.

5. The setup program will now decompress and install the Astrology for Windows files on your 
hard disk.    The setup program will not alter your autoexec.bat file or your config.sys file or win.ini.
It will place its files only in the directory you designate, and the Windows\System directory.    The 
install program will only overwrite system files that have the same or older date.    Should you 
ever need or desire to remove the program from your computer, you need only concern yourself 
with these two directories.

B)

1. Start Windows 3.1 File Manager or Windows 95/98 Explorer.    The fastest way to start Windows 
Explorer is to right-click with the mouse on the Start button and select Explore from the small 
pop-up menu which that gives you.

2. Navigate to the folder where you saved the downloaded ASTWIN23.EXE file.

3. When you see ASTWIN23.EXE in the window showing the folder's files, run it by double clicking 
on it.

4. The WinZip screen will appear, showing the suggested c:\winastro path.    Normally you will click
on the button Unzip to accept this path.    Or alternately you could change the c: to d:, e:, f:, etc.   
Do not delete \winastro as you do not want to install to any drive's root directory.

5. The final action of the self-extracting executable will be to run the INSTALL1.EXE file.    Running 
this program from your hard disk will add the Halloran Software program group either to the 
Win3.1 Program Manager desktop or to Win95/98 Start, Programs, with icons for Astrology for 
Windows and this Help manual.

6. This method of installation will not copy any files to the Windows\System directory.    If you decide 
to remove the program, all files will be in the directory that you created.



What's On The Disks
There are two kinds of files that make up the Astrology for Windows program.    There are the program 
and its data files and there are library files which contain various functions that other Windows programs 
may draw upon.    Since you may have many programs that use these library files, the recommendation 
from Microsoft is that there be just one copy of    the latest version of each of these files in the Windows\
System directory.    For the most compression on the distribution disk and for convenience of installation, 
version 2.3 puts many library files into the WINASTRO application directory.    In three years of distributing
Astrology for Windows on the Internet in this way, this has rarely caused a problem.

Related Topics:
Program Files
System Files
Files created by Astrology for Windows



Program Files
File Description
AST4WIN.EXE The program file.    
ASTTEXT.INI Externalized program captions and messages - allows 

international users to easily localize the program.
ASTTEXT.ENG Backup file of original English captions and messages. 

There are an increasing number of other language 
files, from which the install program will ask you to 
select.    At this writing, you may also select Spanish, 
Portugese, Dutch, Norwegian, Swedish, Italian, 
French, Russian, Czech, Romanian, Finnish, and 
German.

TRANSLAT.TXT Tables of captions to assist translators.
USA.RLE
EUROPE.RLE
WORLD.RLE

Maps used in the on-screen atlas.

AUSCIT.WST
CANCIT.WST
EUROCIT.WST
USCIT1.WST
USCIT2.WST
USCIT3.WST
WORLDCIT.WST

City lists which contain latitude, longitude and time 
zone information.

DELTAT.WST A list of time correction factors used in the planetary 
calculation routines.

STABBR.INI A list of state and country name abbreviations.
AST4WIN.HLP Astrology for Windows on-line Help file.
ADDEMO.EXE Executable file which demonstrates the additional 

features of AstrolDeluxe for Windows.

System Files
FILE DESCRIPTION
VBRUN300.DLL
 GRID.VBX
 CMDIALOG.VBX

Visual Basic Dynamic Link 
Libraries.    Necessary for program 
function.    

 MHRUN300.DLL
 MHEN200.VBX
 MHFL200.VBX
 VSVBX.VBX
 VSVBX.LIC

Other Dynamic Link Libraries.    
Also necessary for program 
function.

COMMDLG.DLL Windows 3.1 Common Dialog 
Library.

HSCALC31.DLL Astronomical calculations library - 
used by Halloran Software 
programs.

Files created by Astrology for Windows
FILE DESCRIPTION



WINASTRO.INI Where Astrology for Windows stores 
user preferences.    

USERCIT.WST Your personal city list.    This list is created 
when you save geographical data from 
within the program.    

CHARTS.CHT Your file of saved charts.    
CHARTS.PTR The index to your saved charts.    If this file 

is corrupted or missing, Astrology for 
Windows will automatically restore it.    

Uninstalling Astrology for Windows
Astrology for Windows does not write to the win.ini file, nor does it place any files in any directory other 
than the directory in which you have installed the program and the Windows\System directory.    For more 
information on where each of the program files is stored, see the table under the heading "What's On The
Disks".

Since everything the program needs is kept in the two directories, it is simple to uninstall the program.    
After backing up whatever files you wish to keep, you may use the File Manager or the Windows 95/98 
Explorer to delete all files in the program directory.    The files in the Windows\System directory may be in
use by other programs on your system.    It is better not to delete those.



Overview
Astrology for Windows gives the hobbyist the ability to perform many complex calculations on natal 
charts quickly and easily.    This chapter will outline how to perform each of these tasks.



Calculating a Chart
Calculating a Natal Chart
Saving a Chart to a File
How To Create a New Chart Based On Data From Another
How To Recalculate a Chart With Revised Birth Data
Calculating a Here & Now Chart
Calculating a Return Chart



Calculating a Natal Chart
To calculate a chart, Astrology for Windows needs two pieces of information:    time of birth and the 
location.    You supply these by filling out the information blanks on the Natal Information Screen.    For 
more information on filling out these blanks, see "Information Blanks".

Once the Natal Information Screen is completely filled out, click on the command button labeled 
Calculate.    The chart will be calculated and displayed on the screen in the Chart Information Screen.

Related Topics:
House and Zodiac Options
Calculation Accuracy
Delta t



House and Zodiac Options
By default, the program calculates a chart using the Tropical Zodiac and the Placidus House System.    
These defaults can be changed through the Customization menu on the Natal Information Screen.    
For detailed instructions on how to make these changes see the headings "Customization    House 
System" and "Customization    Zodiac".



Calculation Accuracy
The calculations are accurate to within a minute for all planets between 1800 and 2100 A.D.    The sun is 
accurate to one second and the moon to within four seconds.    With the exception of Pluto, calculations 
for distant time periods will be accurate to within several minutes.    Pluto is accurate to within two degrees
back to 10 B.C.

The Ascendant and Midheaven calculations are also accurate to one minute.    The program ensures this 
level of accuracy by including nutation of the obliquity in its calculations.    

An improvement made to version 2.3 of Astrology for Windows lies in extending the accuracy of the 
Chiron calculations outside of just the 20th century, to the full period between 1800 and 2100 A.D.    This 
was accomplished by linking to the HSCALC31.DLL calculation library developed for AstrolDeluxe for 
Windows 2.3 and the 16-bit AstrolDeluxe ReportWriter 3.1.



Delta t
In calculating the planetary positions, Astrology for Windows uses a factor known as Delta t to take into 
account the difference between ephemeris time and universal time.    These differences occur because of 
minor fluctuations in the rate of the Earth's rotation.    Values for Delta t are published in the Astronomical 
Almanac and are continuously updated.    Astrology for Windows ships with tables for the years 1620 
through 2009.    For the years 2000 through 2009 the program comes with estimated values.    Outside the
range of the data table, the program uses a formula derived by Morrison and Stephenson for future years 
and two formulas derived by Stephenson and Houlden for the years before 1620 to calculate an 
approximate value.    

As new values become known, the user can edit the file DELTAT.WST so that the program can use the 
new values.    For information on how to edit the table of values of    Delta t see "Updating the Table of 
Delta t Values".



Saving a Chart to a File
Once a chart is displayed on the Chart Information Screen, it can be saved to a file for later recall.    
Unregistered users are limited to saving no more than one hundred charts to the file.

1. After clicking on the File menu, choose Save Chart to File.

2. The chart record will be added to the file "CHARTS.CHT" and the word "Saved" will be printed at 
the top of the screen.



How To Create a New Chart Based On Data From Another
If you wish to calculate a new chart, based on data from another chart in the file, but you wish to leave the
original chart intact, you can use the following procedure.

1. In the Natal Information Screen, select the chart on which you wish to base the new one by 
clicking on the appropriate name in the chart list box.

2. The chart's natal information will be placed in the blanks.

3. Click on the button marked Copy.

4. A copy of the information from the original chart will be placed on the Natal Information Screen, 
and the original chart name will be grayed out in the chart list box.    You may edit the data in the 
Natal Information Screen in whatever manner you wish.    The original chart is still intact.    

5. When you have made all your changes, click on the button marked Calculate.

6. The new chart will be displayed in the Chart Information Screen. 

7. To save this new chart, follow the procedure listed under "Saving a Chart to File".



How To Recalculate a Chart With Revised Birth Data
At times, you may wish to change or update the birth data on which a chart was based.

1. In the Natal Information Screen, select the appropriate chart name in the Chart List Box.

2. The birth data will be inserted into the information blanks.

3. Edit the birth data to reflect the new information.    Make sure you select or highlight the existing 
text in order to replace it, and not add to it.

4. Click on the button marked Calculate.    Do not click on Quick Display.    Quick Display will restore
the old data.

5. The newly calculated chart will be displayed on the Chart Information Screen.

6. To replace the old chart with this new one, choose Save Chart to File in the File menu as 
outlined in "Saving a Chart to File".    The newly calculated chart will be written over the old chart 
in the file.

If you click on the button marked Quick Display after making your changes, the program will replace your
changes with the originally saved birth data, and any new changes will be discarded.



Calculating a Here & Now Chart
You may wish to calculate a chart of the planets and houses at the present moment at your present 
location.    For example, if a client asks you a question to be answered through the rules of horary 
astrology, then you would want to calculate a Horary Chart for the moment that the question was asked.

Related Topics:
Steps to Calculate a Here & Now Chart



Steps to Calculate a Here & Now Chart
1. Be sure that you filled in the User Information form when you installed the program or click now 

on User Information in the Customization Menu of the Natal Information Screen.

2. With the Natal Information Screen in view, click on the button marked Here & Now.    Astrology
for Windows will clear all the boxes and place the current time and location information in the 
correct spaces.

3. Click on the button marked Calculate.

4. The chart will be calculated and displayed in the Chart Information Screen.



Calculating a Return Chart
Astrology for Windows will calculate a Solar Return or Lunar Return for any saved chart.    These are 
usually charts calculated for the time in the present year or month when the sun or moon returns to the 
exact location that it had in the natal chart.    Astrologers analyze a return chart as a guide to the new 
cycle.    To accomplish this, do the following.

1. In the Natal Information Screen, click on the name of the chart for which you wish to create the 
Return Chart.

2. The chart's natal information will be entered into the blanks of the form.

3. From the Options menu, click on Return Chart or, from the Natal Information Screen,    press 
Ctrl-R.

4. A dialog box titled "Return Chart Information" will appear on the screen.

5. In the upper left hand corner of the screen, click on the option button indicating whether you want 
to calculate a solar or lunar return chart.

6. Normally, you will leave the box marked Separation at 0°.    This will give the moment when the 
Sun or Moon has returned to the exact natal position.    However, there may be times when you 
wish to find the moment when the Sun or the Moon is at a specified number of degrees from the 
natal position.    For example, if you wish to know the moment when the Sun is at 90° to its natal 
position, you would enter 90 in the box.

7. In the upper right hand corner click on the option button indicating which Zodiac frame of 
reference you wish to use.    The default is Tropical.    If you select Sidereal, then precession since
the birth date will be subtracted from the natal position.

8. Next enter a date which is at least five days after the expected return date.    The program will 
have entered the present date.    Since the calculations proceed back from the indicated date, you
should enter a date which is safely beyond the expected date.

9. In the longitude box, enter the Native's current longitude in degrees and minutes.    The program 
will have entered the longitude from the User Information you supplied when you installed the 
program.    Use positive numbers¾you can indicate east or west with the option buttons marked 
West and East.

You can automatically insert both the longitude and latitude information by clicking on the button 
City Lists.. and selecting the native's current location.

10. In a like manner, enter the Native's present latitude in degrees and minutes.    Again, the program 
will have entered the latitude supplied by you when you installed the program.    Use the option 
buttons to indicate North or South.

11. Click on the button marked OK.    The program will calculate the chart and display it on the Chart 
Information Screen.    The name assigned to the return chart is designed so that if you save the 
return chart, it will appear in the sorted list of charts next to the natal chart.

12. The File menu option, Compare Return Chart to Natal Chart, will draw a biwheel showing the 
planets of the return chart in the houses of the natal chart.



Chart Reports
Astrology for Windows produces a great deal of information about each chart it calculates, and is 
capable of displaying this information in a number of preformatted reports.

Related Topics:
Printing Charts and Reports
Displaying Graphic Planetary Aspects
Copying Charts and Reports to the Clipboard
Calculating a List of Transits for a Specified Period
Displaying the Aspects of a Single Planet
Displaying a List of Planetary Aspects
Listing Planet Declinations
Determining the Julian Day
Determining the Sidereal Time
Determining the Delta t of a Chart



Printing Charts and Reports
At any time, when the Chart Information Screen is being displayed, users can print whatever report or 
chart is on the screen by clicking on the File menu and then choosing Print.    It is not necessary to select 
or highlight any information before printing.    Programs which are not yet registered will print the graphic 
chart wheel and graphic aspects wheel for your first saved chart (has #1 next to it in the saved chart list 
box), and will print all tabular format reports for any chart displayed.

If a graphic wheel is displayed on the screen when you choose Print, the chart wheel will be printed at 
printer resolution on the default printer that you have set up in Windows.    If you have a color printer, to 
have the chart printed in color, go to the Customization menu and from the Chart Colors screen select 
the Print in Color box.

If a tabular report is being displayed when choosing Print, the entire report will be printed on the Windows 
default printer.    If the report is too long to fit on one page, the following pages will be numbered 
consecutively, starting with page 2.



Displaying Graphic Planetary Aspects
After displaying a chart on the Chart Information Screen, you may select the alternate graphic display 
which shows aspect lines between the planets on a zodiac proportional wheel.

1. From the Display menu, choose Graphic Aspects.

2. The program will draw a proportional wheel in which each planet is shown in its actual position on
the 360-degree zodiac.    Lines will be drawn between those planets where the angle between 
them falls within the orb width of one of the defined astrological aspects (see the Introduction to 
Astrology in the Appendix).    Aspect symbols drawn at the midpoint of the aspect lines help to 
identify all except the conjunction aspect.    See the Appendix for the Aspects table of symbols.

3. To see which aspects are the most exact, click on the left-arrow of the Aspect Orb Width scroll 
bar.    To see wider aspects, click on the right-arrow of the scroll bar.    To see just the major or 
minor aspects or just the harmonious or inharmonious aspects, click on the check boxes within 
the Aspect Types frame.    After you click once, wait for the screen to redraw before clicking 
again.

4. To see exactly which aspects a particular planet makes, double-click on the planet's glyph - this 
calls up a window listing the aspects of just that planet.



Copying Charts and Reports to the Clipboard
Users can, at any time when the Chart Information Screen is being displayed, copy whatever is on the 
display to the clipboard.    This allows you to paste the information into another Windows application such 
as Microsoft Word for Windows or Microsoft Excel or any other Windows application which supports the 
Paste menu command.    The only exception to this is with the graphic wheel:    if you have not yet 
registered, you can copy only the graphic wheel of the first saved chart.

Related Topics:
The Chart and Graphic Aspects Wheels
Tabular Reports



The Chart and Graphic Aspects Wheels
1. If you wish to copy the graphic wheel to the clipboard, make sure that the chart wheel or graphic 

aspects wheel is being displayed.    If you have displayed another report, click on Chart or 
Graphic Aspects in the Display menu.

2. When the chart is displayed, click on Copy to Clipboard in the Edit menu or type Ctrl C.    It is 
not necessary to select any data.

3. The chart wheel is now on the clipboard.    To paste the chart wheel into another application, 
activate that other application, open a document, optionally insert and draw a frame, place the 
cursor where you wish to insert the graphic picture, and select Paste from the application's Edit 
menu, or press Ctrl V.

4. The chart will be pasted into the other application's document as a bitmap.



Tabular Reports
1. If you wish to copy one of the tabular reports to the clipboard such as the Table of Aspects or the 

Table of Planets and Houses, first decide if you want the information block with the native's birth 
data and chart type included.    If so, select Copy Text Report to Clipboard or press Ctrl-T.    
This text report with complete chart data lets you easily share charts with your on-line friends by 
pasting into messages to them.    If you just want information from within the grid, you must first 
select the data you wish to copy.

2. To select just part of a table to copy, hold down the left mouse button and drag the mouse cursor 
over the table.

3. To select all of    a table's contents to copy, click on the Select All command in the Edit menu, or 
type Ctrl-A.

4. All the selected data will be highlighted.

5. To copy the highlighted data to the clipboard, click on Copy to Clipboard in the Edit menu or 
type Ctrl-C.

6. The data is now on the clipboard and may be pasted into a document created by another 
application by selecting Paste from that application's Edit menu, or typing Ctrl-V.    You can 
ensure that the columns fit within your tabs or cells by setting a small character or font size such 
as 7 points and/or by increasing your tab spacing/column width.

7. The data will be pasted into the other application's document as text.    If you are pasting into 
Microsoft Word, the table will be pasted as a series of tab delimited paragraphs which can be 
selected and formatted into a table with the Convert Text to Table command in Word's Table 
menu.    If any text wraps to the next line, increase the column width in the Table menu.

8. If you are pasting into Excel, the table's columns and rows will be preserved in the Excel column 
and row structure.    If you will be pasting the Planet & House Table into a spreadsheet, we give 
you the ability to display the data in a 360 degree purely numerical format.    You can select this 
format by clicking the toggle button beneath the table.



Calculating a List of Transits for a Specified Period
Astrology for Windows will calculate and display a list of transiting planet aspects to any chart in your 
saved chart file, for any period up to twelve months.    The length of the period for which transits may be 
calculated is governed by which planets you have selected for the calculation.

Below is a table showing the maximum period for each starting planet.
Starting Planet Maximum Transit Period in Months
Moon 1
Mercury
Venus

3

Sun 6
Mars
Jupiter
Saturn
Uranus
Neptune
Pluto

12

See also "Comparing Two Charts" for a discussion on comparing a chart to the current transits.

Related Topics:
To Calculate a List of Transits



To Calculate a List of Transits
1. In the Natal Information Screen, select a saved chart from the Chart List Box.    If you have not 

yet registered the program, select only your first saved chart (has #1 next to it in the saved chart 
list box).

2. The chart's information will be entered into the blanks on the Natal Information Screen.

3. From the Options menu, select Transits or, from the Natal Information Screen,    press Ctrl-T.   
(Transits will be grayed out and unavailable until a saved chart has been selected.)

4. The Transits Options screen will be displayed.

5. Under Starting Date, the program will have entered the current date.      Enter the month, day and
year beginning the period for which you wish to calculate transits.

6. Under Native's Time Zone, the program will be showing the time zone you have selected in the 
User Information Screen.    Select the time zone in which the subject currently resides by clicking 
on the arrow of the list box.    If you use a Daylight Savings Time Zone, the results will be based 
on that time zone even though the period of transits selected may span a time of year in which 
Standard Time is in effect.    Your choice here will not affect the User Information elsewhere in the 
program.

7. Under Aspects, select either the 5 Major Aspects or All 11 Aspects by clicking on the 
appropriate option button.    Selecting the 5 Major Aspects option will calculate for the 
Conjunction, Opposition, Trine, Square, and Sextile.    Selecting the All 11 Aspects option will 
add, in addition to the above five aspects, the Semisquare, Sesquiquadrate, Inconjunct, Quintile, 
Biquintile, and Semisextile.    

8. Under Starting Planet, indicate with which planet you wish to start by clicking on the Starting 
Planet down arrow and then clicking on the name of that planet.    

9. Clicking on the scroll bar in the box labeled For How Many Months? will increase or decrease 
the number of months for which the program will calculate.    The value range of the scroll bar is 
dependent on which planet has been selected as the starting planet.    Selecting the Moon as the 
starting planet will only allow you to select 1 month as the number of months.    Selecting Mercury 
or Venus as the starting planet will extend the range of the scroll bar from 1 to 3 months.    
Selecting the Sun will give you a range of 1 to 6 months.    Selecting Mars, Jupiter, Saturn, 
Uranus, Neptune or Pluto will give you a range of 1 to 12 months.    As an alternative, you may 
type the number of months inside the box, however you will be restricted to the range of the 
planet which is currently selected.

10. Once you are satisfied with your entries, click the OK button to start the calculations.    Clicking on
Cancel will return you to the Natal Information Screen.

11. The program will estimate the time needed for the calculations and give you an opportunity to 
cancel or proceed.

12. During the calculations a box showing which planet is being calculated and what percent of the 
planet's calculations are complete will be visible.    On this box is a button labeled Cancel.    If you 
wish to stop the transit calculations click on this button and you will be returned to the Natal 
Information Screen.

13. Once the calculations are complete, they will be displayed in a list box on the Chart Information 



Screen.



Displaying the Aspects of a Single Planet
Once a chart is displayed in the Chart Information Screen, you may pop up a window displaying the 
Aspects of a single planet while keeping the chart on screen for reference.

1. Double click on the glyph of the planet whose aspects you wish to list.

2. A window will appear listing that planet's aspects.

For more information see Aspect Window for Single Planets.



Displaying a List of Planetary Aspects
After displaying a chart on the Chart Information Screen, you may list all the aspects of the depicted 
planets.

1. From the Display menu, choose Aspects List.

2. A list of all the aspects in the chart will be displayed.    

3. To sort the list so that the aspects whose orbs are closest to being exact are at the top, click the 
button below the list labeled Sort By Orbs, or press Alt-S.    



Listing Planet Declinations
After displaying a chart in the Chart Information Screen, a list of the declinations of the planets of a 
chart may be obtained.

From the Display menu, choose Supplemental Calculations.



Determining the Julian Day
After displaying a chart in the Chart Information Screen, the Julian Day may be obtained.

From the Display menu, choose Supplemental Calculations.



Determining the Sidereal Time
After displaying a chart in the Chart Information Screen, the Sidereal Time of a chart may be obtained.

From the Display menu, choose Supplemental Calculations.



Determining the Delta t of a Chart
After displaying a chart in the Chart Information Screen, the Delta t factor of a chart may be obtained.

From the Display menu, choose Supplemental Calculations.



Comparing Two Charts
Displaying a Double Chart Wheel
Displaying the Synastry Between Two Charts
Displaying the Current Transits for a Chart



Displaying a Double Chart Wheel
It is often useful to compare two charts by drawing a biwheel which shows the planets of both charts, with 
the second chart's planets placed in the houses of the first chart.    Astrology for Windows allows you to 
compare any displayed chart to another chart, whether saved, entered, or calculated from the Here & 
Now button on the Natal Information Screen.    This latter choice allows you to compare a natal chart to 
the current placement of the planets, in essence, giving you a picture of the current transits to the natal 
chart.

After displaying a chart, from the File menu choose Compare this chart to another.

The Natal Information Screen will appear.    The caption changes to tell you that you are in the 
middle of a comparison.    Clicking on the button marked Cancel will abort the compare operation 
and leave you at the Natal Information Screen.

Select a saved chart from the Chart List Box, or click on Here & Now, or enter information for a new 
chart.

Click the button marked Calculate.

The double chart wheel will be displayed in the Chart Information Screen.



Displaying the Synastry Between Two Charts
After displaying a double chart wheel (see "Displaying a Double Chart Wheel"), click on Synastry in the 
Display menu.

If the second chart is of the current transits, obtained by clicking on the Here & Now button on the Natal 
Information Screen, you will be given a choice of displaying either a list of transits or synastry.

Choosing Chart Synastry will display a list of aspects between the two charts, the angles formed by the 
planets involved, their orbs and a value.    At the bottom of the list will be listed four indexes: a harmonious
communication index, an inharmonious communication index, a compatibility index, and a total 
communication index.    For a discussion of these indexes see "The Synastry Weighting System" under 
the heading "Display    Synastry".

If you click on the button below the list or press Alt-S, the program will sort the synastry aspects so that 
the strongest are at the top of the list.



Displaying the Current Transits for a Chart
Astrology for Windows provides a way to draw a double chart wheel showing the current transiting 
planets in the houses of any Natal Chart.

1. In the Natal Information Screen, select a primary chart by clicking on a chart name in the chart 
list box or entering the data for new chart.

2. Click on Quick Display or Calculate depending on whether the chart is from the file or new.

3. Once the chart is displayed in the Chart Information Screen, select Compare This Chart to 
Another in the File menu.

4. You will be returned to the Natal Information Screen.    Click on the Here & Now button.

5. The current date and time, and the location you listed in the User Information Screen will be 
inserted into the blanks.    Edit this information to match the location and time you wish for the 
transit chart.    Leave "Current Transits" in the Name field.

6. Click on the Calculate button.

7. A double wheel chart will be displayed in the Chart Information Screen showing the primary 
chart in the inner wheel and the current transits in the outer wheel.    The retrograde flag (R) is 
shown in the outer wheel so that you can see which transiting planets have retrograde motion.

8. To display a list of the aspects made between the primary chart and the current transits click on 
Synastry in the Display menu.

9. You will be given a choice of displaying either the synastry or transits of the two charts.    Select 
Transits.

10. A list of aspects formed between the transiting planets and the planets of the primary chart will be
displayed along with the angles formed by the planets involved, their orbs and a direction.    An 
"applying" direction signifies that the transiting planet is moving toward the exact position of the 
aspect, while a "separating" direction signifies that the transiting planet is moving away from the 
exact position of the aspect.    "Partile" means that the aspect is exact.    Pay the most attention to 
applying aspects that have a small orb.

11. You can click the button labeled Sort By Orbs or press Alt-S to sort the transiting aspects so that
the closest aspects are at the top of the list.



Using the Atlas
Astrology for Windows provides an on-screen atlas in the form of lists of cities and, for registered users,
on-screen maps.

Related Topics:
City Lists
Maps
Creating a Personal City List



City Lists
Astrology for Windows provides up to eight lists of cities allowing easy capturing of geographical data 
for charts.    

1. In the Natal Information Screen, from the Atlas menu choose City Lists.

2. A window will be displayed giving choices of United States, Canada, Australia, Europe, and 
World.    If you have saved location information to a Personal City List, that selection will also be
available.    The area last accessed will automatically be chosen and its states or countries put in 
the list box.    To change the area, click on it, or press its initial letter, or cursor down or up to 
highlight it.

3. The State List Box in the upper center of the window will receive the focus.    Click on this box or 
type Alt-Down Arrow to see a list of states.    If the list of states is longer than the list box, you 
can scroll the list by using the scroll bar    Alternatively you may type the first letter of the state or 
province to immediately select that state.    After choosing U.S. Alaska - Florida, typing "D" or "d" 
will display the cities for Delaware.    Typing "D" or "d" again will list District of Columbia.    You 
may also display the cities for a state by clicking on the state name with the mouse or hitting the 
space bar when the state name is highlighted.

4. Typing Tab will switch you to the City List Box.    You may scroll through the city list by using the 
scroll bar and the mouse as above.    Alternatively, you can type the first letter of the city you are 
looking for and the first city in the list starting with the letter you typed will be selected.    Each time
you type the same letter, the selection will move to the next city which starts with the typed letter.  
If there are no further cities starting with the letter you typed, the first city starting with that letter 
will again be selected.

5. Selecting a city by use of the mouse or the keyboard inserts that city's latitude, longitude, 
standard time zone, city name and state/country name into the Natal Information Screen.

6. Click on Close or type Alt-C to close the window when you are finished.



Maps
The on-screen maps are fully available to registered users.    Unregistered users have the full function of 
the World map available to them and may view the United States and European maps.    To access the 
on-screen maps, do the following:

In the Natal Information Screen, select Maps from the Atlas menu.

A sub-menu will be displayed giving choices of United States, Europe, and World.    Click on the 
map which gives the area you need.

A high resolution color map will be displayed.    The map may not remain on the screen or display if 
Windows Setup shows a driver that uses more than 256 colors.

In the lower right hand corner of the screen is a box which records the location of the mouse cursor 
which is now in the shape of a cross hair.    As you move the mouse cursor around the screen, the
information in the box will change.    For fine adjustments of the location, move the mouse cursor 
slowly.

When the center of the mouse cursor is over the location you wish to record, click the left mouse 
button.

The country/state, latitude, longitude and time zone will be inserted into the proper blanks on the 
Natal Information Screen.

Choose Close from the File menu to return to the Natal Information Screen.

Related Topics:
Moving the Map Information Box



Moving the Map Information Box
At some screen resolutions the Map Information Box may cover a portion of the map you wish to read.

1. In that case, move the mouse cursor over the box.    The cursor will turn into a four pointed arrow. 
If it becomes a standard mouse arrow, move the cursor to another place in the box until it 
becomes a four pointed arrow.

2. Hold down the left mouse button and drag the box to the desired position.    As you drag the box 
to its new position, an outline of the box will indicate where the box will come to rest.

3. Release the left mouse button.

When moving the box, you must drag the mouse cursor beyond the old border of the box or the box will 
not move.    In other words, if you wish to move the box up a very small distance, position the mouse 
cursor at the top of the box so that when you drag the box to its new position, the mouse cursor is no 
longer within the borders of the old position.



Creating a Personal City List
Locations which do not appear on any of the city lists but which you wish to have handy for future use 
may be added to a Personal City List.    This list functions like the other city lists which come with the 
program.

To save geographical data which you have entered on the Natal Information Screen, do the following:

1. From the File menu select Save Geographical Data.

2. If the city already exists in your Personal City List, the program will ask you if you wish to 
overwrite the previous information, add the duplicate version of the city to the file, or cancel the 
operation.    Click on Yes to overwrite the old information, click on No to add the new entry to the 
list while retaining the old, click on Cancel to cancel the operation.

3. The geographical data will be saved to the file usercit.wst.

Related Topics:
Editing the Personal City List
Saving Duplicate City Names



Editing the Personal City List
To change the information you have saved for a particular city, recall the city using City Lists in the Atlas 
menu.    Make the changes you wish, and resave the city using the Save Geographical Data selection in 
the File menu.    When asked if you want to overwrite the old information, click on Yes.



Saving Duplicate City Names
For some large cities, you may wish to save the city twice with different coordinates.    In that case, when 
asked if you want to overwrite the old information, click on No and the second version of the city will be 
added to the file in addition to the older listing.    To avoid this altogether, you could give the two versions 
slightly different city names such as "Dallas1" and "Dallas2".    Of course, if you followed this practice, you 
would probably want to edit out the "1" or "2" after recalling the information to the Natal Information 
Screen.



Files
Opening a Chart File
Converting a DOS Chart File to Windows Format
Converting a Windows Chart File to DOS Format
Using the DOS-Based Astrodynes Program
Using a DOS-Based Interpretation Program



Opening a Chart File
Astrology for Windows automatically opens the charts.cht file if present, and the names of the charts in
the file will be loaded into the Chart List Box in the upper right hand corner of the screen.



Converting a DOS Chart File to Windows Format
If you have been a user of any of the Halloran Software Astrol(xx) programs for DOS such as Astrol96, 
you can convert your DOS chart file (chart.ast) to the Astrology for Windows format.    The charts are 
recalculated from the birth data in the DOS chart file, so if you want a house system other than Placidus 
or if you want the Moon's true node instead of the mean node, customize the program before performing 
this conversion.    This procedure is unavailable in unregistered programs.

1. While in the Natal Information Screen select Convert DOS Chart File from the File menu.

2. A Find File dialog box will be presented.

3. Click on the drive listing and double click on the directory listing until you are in the correct 
directory.    If chart.ast is present, Astrology for Windows will find and highlight it.

4. Once chart.ast is highlighted, click OK.    If you already have a file called charts.cht, Astrology 
for Windows will ask if it is okay to overwrite the Windows file.    

· Click on Yes to overwrite the old file.    The data in the Windows file will be lost.

· Click on No to append the DOS file to the Windows file.    The data in the Windows file will be 
preserved and the DOS file data will be added to it.

· Click on Cancel to abort the conversion.    No file data will be converted.

7. If you chose Yes or No, Astrology for Windows will proceed to convert the file one record at a 
time.    You will see a progress indicator at the bottom of the screen showing which chart is 
currently being converted, and how many total charts are in the DOS file.    In addition, a color bar
proceeds across the status bar indicating the relative progress of the conversion.

8. As the conversion proceeds, you will see the natal information of each chart read onto the screen.
The chart is then totally recalculated and the newly calculated chart is saved to the Windows 
chart file.

9. The DOS file is not altered by this process.

Related Topics:
Canceling DOS File Conversion
Accessing Converted Charts
Converting Files From Interpretation Programs



Canceling DOS File Conversion
You may cancel the conversion at any time by clicking on the Cancel button on the right side of the 
screen.    If the program is in the process of converting a chart, it will finish that conversion, save the chart 
to the new file and halt the process.    A message will appear telling you how many of the charts were 
converted from the DOS file.



Accessing Converted Charts
The newly converted chart file is immediately available by way of the chart list box in the upper right hand 
corner of the screen.    Click on the box and it will drop down showing an alphabetized list of all charts 
currently in the loaded file.    Click on the chart name you wish to view.



Converting Files From Interpretation Programs
You can use the above method to convert files from other Halloran Software interpretation programs such
as chart.nat generated by the Natal Professional program.    Copy the file and rename the copy to 
chart.ast.    You can then follow the normal conversion procedure.



Converting a Windows Chart File to DOS Format
If you use any of Halloran Software's DOS-based interpretation programs, you will want to convert your 
Astrology for Windows chart file to the DOS format.    This feature is unavailable in unregistered 
programs.

1. In the Natal Information Screen, select Convert Windows to DOS CHART.AST from the File 
menu.

2. If this file already exists in the current directory you will be asked if it is okay to overwrite it.    If you
answer yes, the data in that file will be totally replaced by the new converted chart data.    If you 
answer no, you will be prompted to move the existing chart.ast file to a different directory and 
restart the conversion process.    

3. The chart file will quickly be copied to a file named chart.ast in the DOS program format.    You 
will then be returned to the Natal Information Screen. 



Using the DOS-Based Astrodynes Program
Astrodynes is a technique invented by the Church of Light for analyzing a chart into numerical indexes 
showing the total power, harmony, and discord for the planets, houses, and signs.    It can help you to 
understand a person's life orientation if you know their most powerful planet and you can counsel better if 
you know which life areas will be easy and which will be difficult.

Related Topics:
Moving the Astrodynes Files
Creating a Program Group Icon



Moving the Astrodynes Files
If you own Astrodynes for DOS and wish to use the DOS chart.ast file generated by Astrology for 
Windows, you should move the Astrodynes files to the same directory with the chart.ast and pointer.ast 
files.

1. Copy into the Astrology for Windows directory the adynast.exe and astprins.exe files.

2. If you have already installed it elsewhere on your system, also copy the prntspec.dat and 
savedrve.dat files into the Astrology for Windows directory.

If you own Astrodynes for Windows then you will find that its installation program lets you put it in the 
WINASTRO directory together with the Astrology for Windows charts.cht file.    In order to use 
Astrodynes for Windows you must have registered Astrology for Windows.



Creating a Program Group Icon
You can run any DOS program in Windows by double-clicking on the .exe or .com file in File Manager or 
Explorer, but you can also add the program to the Halloran Software Program Group as follows:

Windows 3.1
1. From your Windows desktop, double click on the Halloran Software Program Group in order to 

make it the active program group.

2. Select the Program Manager's drop-down File menu and select New....    The Program Item 
radio button should already be selected.    Press Enter or click on OK.

3. Under Description, enter Astrodynes.    (If you are adding one of the DOS-based interpretation 
programs to the Halloran Software program group, enter a descriptive name for it here.)

4. Under Command Line, enter the path of your Astrology for Windows directory and the 
Astrodynes filename, such as c:\winastro\adynast.exe.    (If you are adding a DOS-based 
interpretation program, then enter the complete path and filename for it, such as c:\match\
match.exe.)

5. Under Working Directory, enter your Astrology for Windows directory to which you have copied 
the Astrodynes files (eg. "c:\winastro").    (If you are adding a DOS-based interpretation program,
then enter the directory where it resides, such as c:\match.)

6. You can accept the default MS-DOS icon now or you can refer to your Windows Help for 
assistance in choosing a different icon.    If you select Change Icon and Browse, then in 
PROGMAN.EXE there is a nice icon of a report with the letter A on it.

7. Accept the remaining defaults by clicking on OK.

8. If you have already used Astrology for Windows to convert a Windows file to the DOS chart.ast 
file, you can now click the icon in the program group in order to run Astrodynes.

Windows 95
1. From the Start menu, select Settings.

2. Select Taskbar.

3. Select Start Menu Programs and click on the Add button.

4. To create the shortcut, click on the Browse button, navigate to the directory and program that you
want to add, and select it by clicking on it.    Then click Open and Next.

5. In response to the prompt Select folder to place shortcut in:, select Halloran Software and click on
Next.

6. Type a descriptive name in response to Select a name for the shortcut:.

7. At Select an Icon, you might select the picture showing the pencil on the written pages.    Click on 
Finish and click on OK.



Using a DOS-Based Interpretation Program
The preferred way to create interpretation reports now is to use the Windows-based AstrolDeluxe 
ReportWriter program, for information about which please click on Help, AstrolDeluxe for Windows 
Demo, when you are at the Natal Information Screen of the program.    However, you can use the 
Astrology for Windows program to calculate and save all of your charts to a central file to which DOS-
based interpretation programs such as Life Trends, Star Match, Natal Profiles and Natal Professional 
point.    You can run these DOS-based programs from Windows by adding them as icon items to the 
Halloran Software program group as described above.    When you are in the Custom Set-Up menu of one
of these programs, select Customize Chart File Location.    Answer "Y" to the chart.ast question and under
"Drive\Directory designation?" enter your Astrology for Windows directory (eg. "c:\winastro").    The 
interpretation program will try to verify the presence of a chart.ast file in this directory and save the 
location which it will then use for accessing chart records for which to print reports.

In order to put your Windows chart records into a DOS format chart.ast file, you must run the Convert 
Windows to DOS CHART.AST option in the Natal Information Screen File menu.    To have newly 
calculated charts available to the interpretation programs, you must rerun this option.    You will find that it 
is a quick process.

Related Topics:
Printing from a DOS-based Reportwriter in Windows 95



Printing from a DOS-based Reportwriter in Windows 95
Turn off the Windows 95/98 print spooler for your DOS program print jobs.    The Windows 95 print spooler
can cause the page breaks to work incorrectly and can break off a long report before it is finished.

1. From the Windows 95/98 Start menu, go to Settings and select Printers.

2. Highlight your printer and select File, Properties.

3. Select Details and the Port Settings button.

4. Turn off the Spool MS-DOS print jobs option.



Entering or Editing the User Information
In the Natal Information Screen, click on User Information in the Customization menu.

You can automatically insert your location by clicking on the button City Lists.. and selecting your current 
city.    If your location is not listed, fill in your City, State or Country, Latitude, Longitude and Time Zone as 
asked for by the captions of the blanks.    To select one of the formal time zones (including daylight 
savings time) around the world, you can click on the time zone list box and select from the list.    Clicking 
on a time zone in the list box will put the correct figures into the Hrs., Min, and Sec boxes, and will check 
the appropriate button for West or East.    If you change your system clock to Daylight Savings Time 
instead of leaving it at Standard Time, be sure that you enter the Daylight Time Zone at this screen by 
clicking on the Time Zone List Box.    Note that Windows 95/98 can automatically change your system 
clock by one hour in order to make the transition to and from daylight savings time.

Clicking on Cancel will return you to the Natal Information Screen without saving your changes.    
Clicking on Save will save your entries and return you to the Natal Information Screen.



Updating the Table of Delta t Values
For an explanation of Delta t, see "Delta t".

When new updated values for Delta t become available, the user can edit the Delta t table of values in the
file DELTAT.WST.    

Related Topics:
Editing DELTAT.WST



Editing DELTAT.WST
1.    Make a backup copy of DELTAT.WST.

2.    Using a word processor capable of handling ASCII text files such as Windows Notepad, open 
DELTAT.WST.

You will notice that the file begins with:
@1620
/* 1620.0 thru 1659.0 */
12400, 11900, 11500,...

This file uses the structure of ten numbers per line, each number separated by a comma.    It is not 
necessary to have exactly ten numbers per line but it will make it easier to spot if you have left a number 
out.

The "@" symbol tells the program that the number which follows is the first year in the table.

The symbols "/*" tell the program that what follows on that line is a comment and should be ignored.

The list of numbers which follow has a value (in hundredths of seconds) for each year consecutively (i.e. 
12400 for the year 1620, 11900 for the year 1621, etc.).    The value listed for 1620 above, "12400", 
represents 124.00 seconds.

At the bottom of the file, you will see the following:
/* Estimates for 2000 thru 2009 */
6460, 6560, 6700, 6800, 6900, 7000, 7100, 7200, 7300, 7400
~2009

Place your cursor at the end of the number 7400, add a comma, and press Return.    A new line will be 
created.    Type your new values in hundredths of seconds, one for each year you are updating, separated
by commas.    The last line of the file "~2009" tells the program that the last year which has a value in the 
table is 2009.    If you have updated the table to the year 2019, then after the tilde, replace "2009" with 
"2019".    You can also modify the above values as actual data becomes available.

Save the file as text only (meaning that no formatting is included) under the name DELTAT.WST.



Short Cuts
Date and Time Entry
Entering Current Location and Time



Date and Time Entry
To enter the current system date on the Natal Information Screen, click on the date displayed on the 
menu bar.

To enter the current system time on the Natal Information Screen, click on the time displayed on the 
menu bar.



Entering Current Location and Time
To enter the current system time and date and your geographic location (the location entered in the User 
Information Screen) click on the button labeled Here & Now.



Translating for Different Countries and Languages
The program automatically uses the date order set in Control Panel, International or Regional Settings, 
Date Format.    For example, on the Natal Information Screen the order of the entry fields for day, month,
and year will change depending on which country you select in Control Panel and its default Short Date 
Format.    The format in which the date prints on your charts and reports depends on the Long Date 
Format.    Whether the program uses a period or a comma as a decimal separator depends on what is set 
in the Number Format section, which also defaults depending on the country selection.

To localize Astrology for Windows for a different language, use a text editor like Notepad or Win95/98 
WordPad (in the Accessories program group) to translate the ASTTEXT.INI file to your language.    
Astrology for Windows reads this file upon startup and gets all of its screen captions and messages 
from it.    You can open and resize two copies of Notepad simultaneously so that one window shows 
ASTTEXT.INI and the other window shows the ASTTEXT.ENG file.    Do not change the ASTTEXT.ENG 
file.      I recommend that you translate a few lines, save your changes, use Control-Escape or Alt-Tab to 
switch to Program Manager where you can start Astrology for Windows to test whether it works, exit 
Astrology for Windows, save to a backup file, and then translate some more.    This way, if it doesn't 
work, you can restore your backup file to the name ASTTEXT.INI and translate a line at a time until you 
discover what is not working and correct it.    You don't have to start at the beginning of the file.    If you 
want the planet and sign names or weekday and month names in your native language immediately, you 
can translate just that section of the ASTTEXT.INI file.    To assist translators in assigning the underlined 
ALT-key characters in menu choices, there is a file TRANSLAT.TXT which has tables of the captions for 
each menu.

If your language uses more words than English, find a substitute for Windows 3.1 Notepad.    The Spanish
language file is already too large for it (although not for Windows 95/98 Notepad).

You may contact Halloran Software to see if we already have a file for your language.    If we do not have 
a file, we offer free registrations in exchange for a translated file.



Overview
The Natal Information Screen is the heart of Astrology for Windows.    It covers several functions.    
Registered programs allow you to:

enter the birth data of the chart subject;

perform file conversions between the structure used in the DOS versions of Halloran Software 
programs and Astrology for Windows;

save the geographical information you have entered to a personal city list;

print a listing of all the subjects in a chart file with their birth information;

compute Transiting Aspect Lists and Return Charts;

customize various aspects of the program such as which House System to use, the Zodiac (tropical 
or sidereal), which planets to include, the chart colors and whether to print in color, the printer 
fonts used in the text reports, the boldness of the graphic glyphs, your personal information, 
which display screen you want to see initially, sorting charts alphabetically, and auto 
capitalization;

access the on-screen atlas for lists of cities and color maps;

duplicate or delete a chart within the chart file;

instantly enter the current time and place information at the click of a button;

and calculate and display the chart.



Information Blanks
Filling in the blanks on the Natal Information Screen is like filling out a form.    This gives the program the
information that it needs to calculate a chart.

Related Topics:
Moving the Cursor
First Name
Last Name
Gender
Date of Birth
Time of Birth
Capture Atlas Data
Longitude
Latitude
Hours Difference from Greenwich
City
Country/State
Remarks
Status Bar
Chart List Box



Moving the Cursor
You may move between the blanks with the mouse, with the Tab key, or by hitting Return (Enter).    This 
last option has been enabled for the sake of users who are new to Windows.    You should accustom 
yourself to using the Tab key as this is the Windows standard.    Pressing Shift-Tab moves the cursor to 
the previous blank.

If you return to a blank to edit data, make sure that the data is highlighted so that you replace it instead of 
adding to it.    When you tab into a field, the data is automatically highlighted.    If you are within a field with
the cursor shown as a thin vertical line, highlight the data by holding down the left mouse button and 
dragging across the data, or alternately, position the cursor where you want highlighting to start and hold 
down the shift key while you press the right-arrow key.



First Name
Enter the first name and the middle initial if applicable.    If you enter more than 20 characters it will be 
truncated to twenty characters when it is saved.    The first letter of the name will be automatically 
capitalized if Customization    Auto Capitalization has been checked.



Last Name
Enter the last name.    As in the First Name Blank, if you enter more than 20 characters it will be truncated 
to twenty characters when it is saved.    The first letter of the name will be automatically capitalized if 
Customization    Auto Capitalization has been checked.



Gender
Click the option which applies or press the initial letter "M", "F", or "N" after you have tabbed into this field.
You may use the Neutral selection for an event.    Neutral is selected for you when you click on the Here 
and Now button.



Date of Birth
The order of the Month, Day, and Year fields is determined by the Short-Date format that is set in the 
International or Regional Settings section of the Windows Control Panel.    See your Windows manual for 
more information.

Related Topics:
Mo
Day
Year
AD / BC



Mo
Enter the month number in the box marked Mo (1 for January, 2 for February, etc.).    Astrology for 
Windows will format a single digit entry with a leading zero, such as "01".



Day
Enter the day of the month.    Astrology for Windows will format a single digit entry with a leading zero, 
such as "01".



Year
Enter all four digits of the year.    Astrology for Windows will format a year of three or less digits with 
leading zeros.    For example, 948 would be formatted as 0948.    If you enter a two digit year such as "47",
the program will ask you if you really meant to enter a year in the first century AD.    To avoid this message
when entering a first century date, enter it with two leading zeros such as "0047".



AD / BC
Before Christ or Anno Domini.    Click on the appropriate choice as to whether the year is before or after 
the birth of    Christ.    The term BC is used on the screen for the sake of brevity.    The program actually 
uses the astronomical year numbering system according to which 1 BC = 0, 2 BC = -1, 3 BC = -2, and so 
on.    To enter March 19, 4 BC you should enter 03 Mon, 19 Day, 0003 Year, and click the BC button.    
The date will print on reports as "19 March -0003".



Time of Birth
This field asks for the time of birth as recorded on the birth certificate.    Astrologers who "know too much" 
should not enter Local Mean Time.    The best way to understand this is that you are entering the local 
time for the central longitude which defines the time for the entire time zone where the birth took place.    
As long as the time zone deviation from Greenwich which you enter at the time zone box corresponds to 
the central longitude (which usually gives a whole hour), then the time of birth must be expressed 
according to this same time zone.

If Daylight Savings time was in effect, the Windows program differs from the DOS program in that instead 
of subtracting an hour to convert the time to Standard Time, you can select a Daylight Time Zone at the 
Time Zone List Box.

Related Topics:
Hours
Min
Sec
AM / PM / Unknown



Hours
Enter the hour of birth.    Use a twelve hour clock.    1:00 in the afternoon should be entered as 1 or 01, not
13.    The program will format a single digit entry with a leading zero.



Min
Enter the minutes after the hour.    The program will format a single digit entry with a leading zero.



Sec
Enter the seconds, if known.    The program will format a single digit entry with a leading zero.    If the 
seconds are not known, leave the entry as "00".



AM / PM / Unknown
Click on the appropriate button to indicate before or after noon.    Use AM for times from 12:00:00 
midnight to 11:59:59 in the morning inclusive.    Use PM for times from 12:00:00 noon to 11:59:59 at night 
inclusive.    Clicking on Unknown will zero out the hours, minutes and seconds, and place the words 
"Unknown birth time." in the Remarks box.    Selecting this option will cause the program to calculate the 
planets for noon of the day indicated, and will place them in a solar equal house chart.    Aspects and 
comparisons involving this chart will ignore the resulting Ascendant and Midheaven.



Capture Atlas Data
At this point, you can automatically fill in the blanks for Longitude, Latitude, Hours Difference from 
Greenwich, City, and Country/State by accessing the Atlas city lists or, if registered, maps.    If you know
the coordinates for a city which is not yet in the database, continue to fill in the blanks; when you are 
finished you can save geographical data to your personal file.    (See "File          Save Geographical Data")

Those users who elect to upgrade to Halloran Software's AstrolDeluxe for Windows may also purchase 
and capture data from the PC Atlas or Mini Atlas databases by ACS Publications, Inc.    The PC Atlas is a 
vast database of geographical and time zone changes information.



Longitude
Enter the degrees of longitude in the box preceding the degree mark (º).    An entry of one or two digits will
be formatted with leading zeros to make a three digit number.

Enter the minutes of longitude in the box preceding the minutes mark (').    A single digit entry will be 
formatted with a leading zero.    You can enter seconds of longitude in the form of a decimal such as 
"15.5" or in the form of seconds by using a colon, such as "15:30" for 15 minutes and 30 seconds.    If you 
use a colon, the program will automatically convert your entry to decimal seconds.

Related Topics:
West / East



West / East
Click on the appropriate button to indicate whether the location is West or East of Greenwich, England 
(Prime Meridian).    000º 00' is shown as West.



Latitude
Enter the degrees of latitude in the box preceding the degree mark (º).    A single digit entry will be 
formatted with a leading zero.

Enter the minutes of latitude in the box preceding the minutes mark (').    A single digit entry will be 
formatted with a leading zero.    Enter seconds of latitude by entering a decimal minute or by preceding 
them with a colon (see "Longitude").

Related Topics:
North / South



North / South
Click on the appropriate button to indicate whether the location is North or South of the Equator.    00º 00'
is shown as North.



Hours Difference from Greenwich
Daylight Savings Time and War Time
Time Zone List Box
Hrs
Min
Sec
West or East



Daylight Savings Time and War Time
When you tab into the Hours Difference from Greenwich field, the program will evaluate the date that 
you entered and warn you if War Time or Daylight Savings Time could have been in effect.    You can rely 
on the program's War Time indication for U.S. and Canada births, but not upon the Daylight Savings Time
warning because the start and end dates vary each year and not all states observe Daylight Time.    For 
this reason it is important to have a reference work for time changes such as Thomas G. Shanks 
American Atlas and International Atlas.    Alternately, if you upgrade to AstrolDeluxe for Windows, you 
can purchase and install the PC-Atlas or Mini Atlas.    Both the books and databases are available from 
Halloran Software.



Time Zone List Box
If the time zone you want is one of the formal time zones from around the world, you can select it from the
Time Zone List Box located in the frame captioned Hours Difference From Greenwich.    Selecting a 
time zone from the list will automatically fill in the appropriate hours and minutes and will click the 
appropriate West or East button.    (A short cut to get to the European time zones at the bottom of the list 
is to type Ctrl-End.)    Universal time or Greenwich Mean Time is shown as being 00:00:00 West.    

If it is a Local Time which you wish to enter, you may enter the time zone directly as is described in the 
following sections.



Hrs
Enter the hour of the time zone.    For the Pacific Time Zone in the United States, you would enter "8" or 
"08".    A single digit entry will be formatted with a leading zero.



Min
If appropriate, enter the number of minutes of the time zone.    For example, India's standard time is 5 
hours 30 minutes East of Greenwich.    For India, you would enter "30" in the Min box.    A single digit entry
will be formatted with a leading zero.



Sec
The Netherlands used Amsterdam's meridian which is 0h 19m 32s East of Greenwich as the Standard 
Time Zone for the whole country between May 1, 1891 and July 1, 1937.    In this instance you would 
enter 32 in the Sec box.    A single digit entry will be formatted with a leading zero.



West or East
Click on the appropriate button to indicate whether the time zone is west or east of the prime meridian.    
00 hours, 00 minutes, 00 seconds is shown as West.



City
Enter the name of the city of birth.    If you enter a name of more than thirty characters, the program will 
truncate the name to thirty characters when the chart is saved.    It is not necessary to enter a comma 
after the city name.



Country/State
Enter the name of the country or state of birth.    If you enter a name of more than thirty characters, the 
program will truncate the name to thirty characters when the chart is saved.



Remarks
This box is used for notes which you may wish to attach to the chart.    The program will enter "Unknown 
birth time." in this box if you click on the Unknown option in the Time of Birth entry.    Other information 
you could enter here would be the source of the chart information.    You will not be able to enter remarks 
of more than thirty characters.



Status Bar
The status bar at the bottom of the screen will show progress information for various tasks such as file 
conversion.



Chart List Box
Clicking on the drop-down Chart List Box in the upper right corner of the screen will allow access to your 
saved charts in the currently loaded file.    Use the mouse to scroll down the list and click on the desired 
chart.

Alternatively, you can type Alt-V to access the Chart List Box and open the list with Alt-Down arrow.    
Then type the first letter of your subject's last name, or use the down arrow to step through the listings.    
Each name which appears will be loaded into the Natal Information Screen.



File Menu
File        Save Geographical Data
File        Convert DOS Chart File
File        Convert Windows to DOS CHART.AST
File        Print Subject Data List
File        Exit



File        Save Geographical Data
Clicking on this will save the current city and country/state names along with the current longitude, 
latitude, and time zone to a personal city list.    This information can be retrieved at any time through the 
Atlas menu.    The city information is saved to a file named usercit.wst.    For more information see "Atlas".



File        Convert DOS Chart File
This selection converts the file of saved charts from the DOS version of Astrology to the format used by 
Astrology for Windows.    You will be asked to navigate through a file finder dialog box to the directory 
where your DOS file is located.    For more detailed information on converting a DOS chart file see 
"Converting a DOS Chart File to Windows Format".



File        Convert Windows to DOS CHART.AST
This selection will convert the chart file from Astrology for Windows to the format used by the DOS 
version of Astrology.    For more detailed information on converting the Astrology for Windows chart file
to the DOS format, see "Converting a Windows Chart File to DOS Format".



File        Print Subject Data List
It is sometimes helpful to have a printed list of all the subjects in your file with their natal information.    
This selection will print a formatted alphabetical list of all the charts in your file to the default printer.    In 
case your hard disk fails, it is recommended that you keep a printed copy of your charts' natal information 
as well as backup file copies on floppy disks.



File        Exit
Unloads the program and all associated forms, returning you to the Windows desktop.



Options Menu
Overview
Options      Transits
Options      Return Chart



Overview
Along with computing individual charts and comparing them, Astrology for Windows allows you to 
compute Transit Lists and Return Charts.    These selections are available once a chart has been 
entered in the Natal Information Screen by clicking on a selection in the Chart List Box.



Options      Transits
This selection allows you to compute and list the planetary transits over a specified time for a specific 
chart.

At any time, clicking on Cancel will abort the Transit routine and return you to the Natal Information 
Screen.

Enter the date for which you want the transit period to begin.    The program will have already entered for 
you the current date.

Use the Time Zone List Box to select the zone that will be in effect where the native lives during the 
transits list period.

Click on whether you want all eleven aspects figured, or only the five major aspects.    Selecting the 5 
Major Aspects option will calculate for the Conjunction, Opposition, Trine, Square, and Sextile.    
Selecting the All 11 Aspects option will add, in addition to the above five aspects, the Semisquare, 
Sesquiquadrate, Inconjunct, Quintile, Biquintile, and Semisextile.    

Indicate with which planet you wish to start by clicking on the Starting Planet down arrow and then 
clicking on the name of that planet.    

Clicking on the scroll bar in the box labeled For How Many Months? will increase or decrease the 
number of months for which the program will calculate.    The value range of the scroll bar is dependent on
which planet has been selected as the starting planet.    Selecting the Moon as the starting planet will only
allow you to select 1 month as the number of months.    Selecting Mercury or Venus as the starting planet 
will extend the range of the scroll bar from 1 to 3 months.    Selecting the Sun will give you a range of 1 to 
6 months.    Selecting Mars, Jupiter, Saturn, Uranus, Neptune or Pluto will give you a range of 1 to 12 
months.

Once you are satisfied with your entries, click the OK button to start the calculations.    The program will 
display an estimate of the time required to calculate, giving you the opportunity to cancel or proceed.

During the calculations a box showing which planet is being calculated and what percent of the planet's 
calculations are complete will be visible.    On this box is a button labeled Cancel.    If you wish to stop the 
transit calculations click on this button and you will be returned to the Natal Information Screen.

Once the calculations are complete, they will be displayed in a list box on the Chart Information Screen. 
To Print the list or save it to a text file click on File and then Print or Save Screen as Text File.

Refer to the Glossary for definitions of Upper Hand aspect and Lower Hand aspect.

Related Topics:
Transits Date Format



Transits Date Format
The date of each transiting aspect will display according to the long date format which is set in the 
International or Regional Settings of the Windows Control Panel.



Options      Return Chart
Selecting this option will allow you to cast a solar return chart or lunar return chart for whatever separation
from the natal position you desire.

Select Solar or Lunar depending on which Return Chart you wish to draw.    

If you wish to plot a return to a position other than the natal position, enter the number of degrees 
difference under Separation.    

Choose which Zodiac reference frame you wish to use by clicking on Tropical or Sidereal.    If you 
choose Sidereal, then even though you may have your planet positions expressed according to the 
Tropical zodiac, precession since the date of birth will be discounted and the Sun or the Moon will not be 
in their original Tropical positions as of the date and time of the return chart.    Instead, they will be in their 
original positions relative to the fixed stars or constellations.

Astrology for Windows will automatically enter the current date.    You should enter a date in this box 
which is at least five days after the expected return date.    For example, if the expected return date is 
October 28, 2001, you should enter a date no earlier than November 2, 2001.

Enter the subject's current longitude and whether it is East or West of Greenwich, England.    Astrology 
for Windows will enter the longitude from your user information.    Often this will be the subject's longitude
also.

Enter the subject's current Latitude and whether it is North or South of the equator.

You can automatically insert both the longitude and latitude information by clicking on the button City 
Lists.. and selecting the native's current location.

If you wish to return to the Natal Information Screen without computing the Return chart, click on 
Cancel.    

When you are satisfied with your entries, click on OK to begin the calculation of the chart.    Astrology for
Windows will calculate the return chart and display it as it would a natal chart.

Solar return charts will be calculated to an accuracy of one minute in the Ascendant position.    If you do 
not get the results that you expected, check to see if you selected the Sidereal reference frame which 
omits precession since the date of the natal chart.

You may save this chart or do any report you would do with a natal chart.    In the upper left hand corner of
the chart will be displayed the date and exact time that the Sun or Moon will have returned to the natal 
position.    The time of the return chart will be local mean time for the longitude where the subject lives.    If
you do save the chart, it will have the first name appended to the end of the last name and the words "Rtn
for [date]" will go in the first name field.    The name is expressed in such a way that the return chart will 
appear next to the natal chart in the alphabetized chart list box.

Compare Return Chart to Natal Chart in the File menu of the Chart Information Screen lets you easily
place the planets of the return chart in the houses of the original natal chart.



Customizing Astrology for Windows
The Customization menu allows you to choose the house system, zodiac, and planets to include.

In addition, this menu allows you to customize the output of the program.    You may specify colors for the 
planets, chart circle and background of the graphic wheels, whether the program prints in color, the 
boldness of the glyphs, and the printer fonts used in the text reports.    

You may edit your personal information, select the display screen that first appears, change the order of 
charts in the list box, and toggle on or off Auto-Capitalization.

Related Topics:
Customization    House System
Customization    Zodiac
Customization    Planets
Customization    Printer Fonts
Customization    Screen Chart Colors
Customization    Bold Glyphs
Customization    User Information
Customization    Initial Chart Display
Customization    Sort Charts in Alphabetical Order
Customization    Auto Capitalization



Customization    House System
There are seven different house systems offered in Astrology for Windows.    Click on the system you 
wish to use and then click on Save & Exit to save your choice and return to the Natal Information 
Screen.    If you wish to exit without saving any changes click on Cancel.

To help you decide which system you wish to use, we have included a brief description of each of the 
seven systems.    It is not essential to understand the derivation of the house systems in order to use this 
program.    The user who wishes to delve deeper into the reasons and methods of the various systems 
should consult The Astrologer's Companion by John Filbey and Peter Filbey.    Publishing information is
in the bibliography.

Related Topics:
Placidus
Koch
Equal House Western
Equal House Eastern
Campanus
Porphyry
Alcabitius



Placidus
This is the default system on Astrology for Windows.    It was devised in the seventeenth century by 
Placidus de Tito, an Italian monk and mathematician.    The system was made popular in the English 
speaking world by Raphael's Ephemeris and Raphael's Table of Houses.    A time based system, it is 
derived by taking the time for any degree to move from the ascendant to the midheaven.    This time is 
divided into three equal parts to determine the cusps of the twelfth and eleventh houses.    A similar 
method using the lower meridian (I.C.) and the ascendant is used to determine the cusps of the second 
and third houses.    This house system is not valid for latitudes more than 66º north or south of the 
equator.



Koch
Made popular by Dr. Walter Koch and published in the early 1970s.    Uses the arc of oblique ascension 
from the horizon to the Ecliptic.    The house cusps of the first quadrant are created by dividing the diurnal 
circle of the lower meridian into thirds.    The house cusps of the fourth quadrant are created by dividing 
the diurnal circle of the upper meridian into thirds.    This system is not valid for latitudes greater than 66º 
north or south of the equator.



Equal House Western
This is an ecliptic system attributed to Ptolemy.    The ascendant is determined and then 30º is added for 
each of the house cusps.    This system works in Arctic latitudes.



Equal House Eastern
The Equal House System - Eastern Style assigns each house one zodiacal sign starting from the 
Ascendant or rising sign.    Planets fall within a house if they fall within its zodiacal sign.    Indian 
astrologers use this ancient system of whole sign houses.



Campanus
Devised by Johannes Campanus, a thirteenth century mathematician.    In this system, a great circle 
passing through the zenith (the highest point directly above the location) and at right angles to the 
meridian is divided into twelve equal parts by six intersecting great circles which intersect each other at 
the north and south points of the horizon.    This system works in Arctic latitudes, though not very well.



Porphyry
A modification of the Equal House Western system, divides each of the arcs of the ecliptic between the 
meridian and the horizon into three equal parts.    The houses are equal when the right ascension of the 
Midheaven is either six or eighteen hours.    Otherwise only the houses of opposite quadrants are equal to
one another.    This system works in Arctic latitudes.



Alcabitius
This system comes from the Arabic astrologer Alcabitius (Al-Qabisi), who flourished ca. 960 A.D.    He 
wrote an introduction to astrology that was translated into Latin.    A time-based system, cusps 11 and 12 
are derived by trisecting the time needed for the ascendant degree to rise to the midheaven.    Similarly, 
cusps 2 and 3 are derived by trisecting the time needed for the I.C. degree to rise to the ascendant.    This
system has been undeservedly neglected by modern astrologers, perhaps because the published tables 
are wrong (i.e., Dona Marie Lorenz).    This system works very well in Arctic latitudes.    Version 2 of 
Astrology for Windows adds correct calculation of extreme latitude charts.    I am indebted to the 
generosity of Swedish astrologer Per Dahlin, who prefers this house system, for information on how to 
calculate charts for times and locations where the ecliptic points that are culminating and ascending are 
reversed from the normal ecliptic sign order.



Customization    Zodiac
This selection allows you to choose to construct a chart using either the tropical zodiac or the sidereal 
zodiac.    Do not choose the sidereal zodiac if you do not know what it is.

Click on either Tropical Zodiac or Sidereal Zodiac to select.    If you select Sidereal Zodiac, you must 
enter a delta factor.    

The Sidereal zodiac is tied to the constellations while the Tropical zodiac is tied to the ecliptic-equator 
nodal points.    Precession of the equator causes the nodal points and Tropical zodiac to move relative to 
the constellations at the rate of 1.4 degrees per century.

The program will accept a delta factor of up to 90 degrees in either direction from the standard Western 
sidereal zodiac.    The starting point of this zodiac is based on work by Cyril Fagan and Garth Allen (also 
known as Donald Bradley).    The starting point of the official Indian government sidereal zodiac, the Lahiri
zodiac, is 0 degrees, 53 minutes west of the Western sidereal zodiac.    There are several other sidereal 
zodiacs in use in India.    Customers from India should start by entering a delta factor of 0 and then use 
Astrology for Windows to recalculate a horoscope known to them that was done in the zodiac they use. 
The difference in degrees and minutes between the planet placements in the two charts then becomes 
the delta factor. This difference between the two versions of the sidereal zodiac will remain constant over 
time. 

To save your choices click on Save & Exit.    If you do not wish to save your choices click on Cancel.    In 
any case you will be returned to the Natal Information Screen.

The following is a very brief description of the two zodiacs.

Related Topics:
Tropical Zodiac
Sidereal Zodiac



Tropical Zodiac
The Tropical Zodiac is the default zodiac in Astrology for Windows.    This system uses the positions of 
the Sun at the beginning of each of the four seasons to quarter the zodiac.    The beginning point is the 
position of the Sun at the vernal equinox or first day of spring (0º Aries).



Sidereal Zodiac
The constellations define the Sidereal Zodiac.    In the year 221 A.D., the Tropical and Sidereal zodiacs 
coincided.    Currently, they differ by about 25º.    The Sidereal Zodiac feature of Astrology for Windows 
takes into account and corrects for this precession of the equinoxes.    According to the Sidereal Zodiac, 
the first day of spring occurs when the Sun is around four to six degrees of the constellation of Pisces.    
The Sidereal and Tropical zodiacs coincide about every 26,000 years.



Customization    Planets
Astrology for Windows enables you to specify which planets, in addition to the standard major planets, 
to include in the chart and chart comparisons.    The program's default is to include the Ascendant and 
Midheaven and to exclude the Moon's Nodes, Part of Fortune, and Chiron.    The Part of Fortune is the 
Arabic part for the Moon.    Chiron is a minor planet or large comet between Saturn and Uranus.    

Click on the check box, planet name or symbol for each planet you wish to include in your charts.    
Clicking on the check box, planet name or symbol of a selected planet will deselect that planet.    Be 
aware that increasing the number of selected planets will increase the communication index values that 
you get when evaluating aspects and synastry between charts.

Next to the Moon's Nodes choice are two option buttons labeled Mean and True.    If you have selected 
the Moon's Nodes to be included, click on the appropriate button to indicate whether the program should 
calculate the Moon's True Nodes, or the Moon's Mean Nodes.    These buttons will be disabled if the 
Moon's Nodes box is not checked.

Next to the Part of Fortune choice is a checkbox Reverse for Night Birth.    Check this box to indicate if 
you want the Part of Fortune for night births calculated differently than for day births.    This checkbox will 
be disabled if the Part of Fortune box is not checked.

Click on Save & Exit to save your choices or click on Cancel to exit without saving.

Related Topics:
Moon's Nodes:    Mean vs. True
Part of Fortune:    Day vs. Night



Moon's Nodes:    Mean vs. True
The points where the orbital path of the Moon crosses the ecliptic are the Moon's Nodes.    These points 
move along the ecliptic in a retrograde motion at a rate of approximately 19° per year.    Due to orbital 
perturbations, the position of the nodes does not move at a smooth, regular rate.    The Mean Nodes are 
an average approximation of the position of the nodes.    The Mean Nodes are the nodes which 
astrologers have used for hundreds of years.    In the 1970's some astrologers began using the Moon's 
True Nodes which are an exact representation of the nodes' positions, taking into account the Sun's 
gravitational pull on the Moon.    The difference between the Mean and True Nodes is always within two 
degrees.



Part of Fortune:    Day vs. Night
This version of Astrology for Windows provides the ability to reverse the formula for calculating the 
Arabic Part of Fortune for Night births.    When the box Reverse for Night Birth is checked, the program 
will measure as usual from the sun to the moon for a day birth, but for a night birth it will measure from the
moon to the sun.    It then adds the resulting distance to the longitude of the Ascendant to get the Part of 
Fortune.

When Reverse for Night Birth is selected, the information block on the right side of the chart will start to 
tell you if the chart is a Day Chart or a Night Chart.



Customization    Printer Fonts
Astrology for Windows allows you to choose a header font and a font for the body text of the printed 
reports, including the printed graphic wheels.    The Customization menu will show you menu choices as 
follows:

Header Font (Times New Roman 14 pt.)
Body Text Font (Times New Roman 12 pt.)

The menu choices show what fonts are currently selected for the Header and Body text.    In the above 
case, Times New Roman has been selected for both the Header and the Body Text.    The Header Font is 
14 points and the Body Font is 12 points.

All printer fonts on your computer installed for Windows will be presented in the list on the left.    Once you
have clicked on the font name you want, you may click on a style in the Font Style list and a point size in 
the Size list.    The sample box shows you what your selection will look like.    If you have selected a printer
font which is not installed on your computer as a screen font, you will get a note below the sample box 
telling you that Windows is simulating the printer font as best it can.    True Type fonts are installed for 
both the printer and the screen.

Click Cancel if you do not wish to save your selection.    Click OK to save your selection.    In either case 
you will be returned to the Natal Information Screen.

Astrology for Windows does not support customizing the screen display fonts.



Customization    Screen Chart Colors
The on-screen graphic chart wheel uses the color assigned to each planet glyph to also draw the 
degrees, minutes and sign of that planet.    Although Astrology for Windows comes with preselected 
colors, you may assign any available color to each of the glyphs.

To change the color of a glyph, click on the color of your choice in the box to the right marked Select 
color (the color will be outlined with a heavy border) and then click on the glyph you wish to change.    
The glyph will be instantly redrawn with the new color.

If you wish to change the background color of the chart wheel, click on the color of your choice and then 
click on the rectangle marked Background.    You will immediately see if you need to change the color of 
any of your glyphs, since they will all be depicted against the background color you have chosen.    If you 
have picked cyan for the background and you have a glyph drawn in cyan, it will be invisible and this will 
be apparent.

Clicking on the rectangle marked Chart Circle will let you change the color used for the lines of the chart 
circle, house cusps, and house information.

When you print the graphic chart, the glyphs will be drawn in black against the paper color background 
unless you click on the box labeled Print in Color to check it, in which case every color you have 
selected with the exception of the background color will be sent to the printer.    This is fine if you have a 
color printer, but will produce undesirable gray-scaling on a black and white printer.    Clicking on the box a
second time will uncheck it.

If, at any time, you wish to return to the default colors that came with Astrology for Windows, you can 
click on Return to Default and the original colors will be restored.

To exit without saving your changes, click on Cancel and you will be returned to the Natal Information 
Screen.

To save your changes and exit, click on Save and Exit and you will be returned to the Natal Information 
Screen.



Customization    Bold Glyphs
To check (Ö) this option, use the mouse to click on it or cursor down to it and press Enter.    It will cause 
the glyphs and the numbers of both the screen and printed chartwheel to be drawn with bolder lines.    
Selecting it a second time will uncheck it, and the charts will be drawn with normal line widths.



Customization    User Information
For some procedures, it is necessary for Astrology for Windows to know your geographical location.    
When you first run the program you will be asked for this information.    This menu command enables you 
to edit the information.    For more detailed information see "Entering or Editing the User Information" in 
the chapter titled "Using Astrology for Windows".



Customization    Initial Chart Display
Different program users prefer to see the chart displayed in different formats, either a normal chart wheel 
with planet degrees and minutes, a proportional wheel showing the graphic aspect lines, or a text table of 
the planet and house positions.    This screen lets you choose which display comes up when you calculate
or quick display a chart.



Customization    Sort Charts in Alphabetical Order
When this option is checked (Ö), the charts in the list box on the Natal Information Screen will be sorted 
alphabetically by last name.    Click on this option to toggle back to displaying charts in the order in which 
you entered them.



Customization    Auto Capitalization
Users who have used the DOS Astrol program will remember that the program did not support lower-
case letters in subject names.    As Windows does support lower-case letters, Astrology for Windows 
has an option which will make it unnecessary to press the Shift key for the first letter of the subject's 
names, city and state/country.    If this option is checked (Ö), the program will automatically capitalize the 
first letter of the first and last names, the city and the state/country.    Clicking on this menu selection 
toggles the option on or off.



Atlas
Overview
Atlas      City Lists
Atlas      Maps



Overview
Astrology for Windows has an on-line Atlas which will enable you to find the geographical coordinates 
and time zone for a vast number of locations.    The Atlas is divided into two parts, lists of cities, and 
graphical maps.    Use the city lists when you know the name of the city of birth.    Use the maps when the 
city is not listed in the city lists or you wish to find the coordinates for a non-urban location.    Unregistered 
users can use the city lists and the World map.



Atlas      City Lists
This menu selection gives you access to up to eight separate lists of cities:    three for the United States, 
Canada, Europe, Australia, World and a Personal city list.    The lists contain coordinates for 1465 U.S. 
cities, 431 European cities, 291 Australian cities, 266 Canadian cities and 192 cities in the remainder of 
the world.    The Personal city list may contain as many cities as you care to enter.    For more information 
on saving locations to the Personal City list see "Creating a Personal City List".

To access the city lists, click on Atlas    City Lists.    For complete instructions on using the city lists see 
"City Lists".

The most extensive lists of city longitudes, latitudes and time zones are those for the United States.    We 
created this U.S. database from a database of longitudes and latitudes for every ZIP code in the United 
States.    We screened out small towns by only including cities with multiple Zip codes and where the 
longitude and latitude for the zip codes were different.    The longitude and latitude given for each location 
are averages of all the zip code longitudes and latitudes for that location.    The ACS atlas references give 
the coordinates for a city's civic center, which is not necessarily at the city's geographic center.



Atlas      Maps
The on screen Atlas includes three VGA-resolution maps: United States, Europe, and The World.    
Clicking on Atlas    Maps will bring up a menu of the three maps so that you may choose which map you 
wish to use.    The maps for the United States and Europe may be viewed by unregistered users, but they 
will not return any location information until the program is registered.

The mouse cursor will be shaped like a cross hair.    As you move the mouse cursor around the map, you 
will see the information at the bottom right of the screen change, reflecting the country name (state name 
on the U.S. map), time zone, latitude and longitude of the cursor position.    Clicking the left mouse button 
will enter the information for the cursor's position on the Natal Information Screen.

Click on Exit to return to the Natal Information Screen.



Registration
Overview
Benefits of Registration
Registration Form
Enter Registration Code



Overview
If you have bought a registered copy of Astrology for Windows directly from Halloran Software, you do 
not need to concern yourself with the following section.    If you have received your copy of Astrology for 
Windows as shareware, either an online download or on a disk, the following sections will tell you how 
you can register the program and reap the benefits.



Benefits of Registration
Selecting this item will list the following benefits of registering your copy of Astrology for Windows .

Certain additional functions are provided upon registration of the program for US$26.50.    To add these 
functions, the procedure is to get a registration code from Halloran Software, not a new program disk.

The additional functions include the following:

1.    Access more than 100 saved charts per program copy;

2.    Delete selected saved charts;

3.    Print or copy to the clipboard the graphic wheel for charts other than the first saved chart;

4.    Calculate the list of transits to a natal chart with the exception of transits to the first saved chart;

5.    Access geographical longitudes and latitudes via maps of the United States and Europe;

6.    Convert saved charts from or to the DOS versions of ASTROL.



Registration Form
Choosing this item will open a form for you to fill out in order to register your copy of Astrology for 
Windows .    The information that you enter here will not be electronically communicated to Halloran 
Software.    You must fax or mail the printed form to us.    Instead of completing this form, you can register 
on-line by using the Secure Orders form at the Halloran Software web site at http://www.halloran.com/.

If you do continue on with this form, please fill in your billing address: Name, Street Address, City, State, 
Postal Code, Country (if not the United States), Phone Number (in case we have problems with your 
order), FAX number if you have one, and your e-mail address if you have one.

If the shipping address is the same as the billing address, check the box labeled Same as Billing 
Address.    The blanks will be filled in for you.    If the shipping address is different from the billing 
address, fill in the blanks with the proper information.      Halloran Software normally uses first class mail or
air mail to fill orders.

If you are paying by credit card (Discover, Visa, MasterCard, or American Express), please enter your 
card number, expiration date, and check which card you are using.    We do address verification on our 
credit card orders, so one of the two addresses shown should be the address at which you receive your 
credit card billing statements.

The registration fee is $26.50 US for each copy of Astrology for Windows you are registering.    
Customers who live outside the U.S. must purchase and mail in an international money order which is 
payable on a U.S. bank, if they do not have one of the listed credit cards.    In addition to trying your bank, 
the local American Express office can be a good place to obtain an international money order.

Once you have finished filling out the form, you can print a hard copy by clicking on the Print button.    You
can then either fax the order to the toll-free fax number 1-800-257-4555 or mail the form to Halloran 
Software, P.O. Box 75713, Los Angeles, CA 90075, U.S.A. with your check, money order, or credit card 
information.

As an alternative, if you have a fax-modem and credit card, using the File Printer Setup menu you can 
select your fax-modem as the printer and fax the form directly from Astrology for Windows by clicking 
on the Print button.



Enter Registration Code
Once you have registered your copy of Astrology for Windows, you will be sent a registration code and 
complete instructions for validating your copy.



Help
The help menu provides access to the on-line Help manual and provides information about the software 
company and its other products.

Related Topics:
Using Help
Natal Information Screen
Contents
AstrolDeluxe for Windows Demo
About Astrology for Windows



Using Help
This selection calls up Microsoft's instructions for the beginner on how to use Windows Help together with
a description of its capabilities.



Natal Information Screen
The Help for Astrology for Windows is divided into four sections, task-oriented documentation, Natal 
Information screen reference documentation, Chart Information screen reference documentation, and an 
Appendix which includes symbols, an introduction to astrology, and a bibliography.    This selection takes 
you to the reference documentation for the Natal Information screen.    It thoroughly discusses each part 
of the Natal Information screen.



Contents
The Table of Contents for the Help manual shows all the headings of the manual, letting you immediately 
jump to the section that interests you.    The Contents are always available from the Windows Help menu 
bar.



AstrolDeluxe for Windows Demo
This option runs the demo program which shows the features of AstrolDeluxe for Windows.    The demo
is a self-explanatory program consisting of displays and scrollable list boxes which you can call up by 
clicking on the appropriate buttons.    AstrolDeluxe costs considerably more than Astrology for 
Windows since it is designed for professional astrologers and serious students of astrology.    If you are 
not yet in this group, register Astrology for Windows now and upgrade when you want or can afford 
more.    There is a twenty dollar upgrade discount for registered users of any version of the shareware 
program.

Halloran Software produces and sells calculation programs, interpretation programs, research programs, 
a famous charts database, a TrueType font of astrological symbols, time changes atlas, reference books, 
etc.    If you are looking for a report-writer program, when you send in your registration please tell us that 
and what type of interpretations interest you so that we can include flyers about AstrolDeluxe 
ReportWriter and the appropriate interpretations.    AstrolDeluxe will work with charts saved by 
Astrology for Windows.



About Astrology for Windows
Every Windows program has an About screen.    We are no exception.    The About screen gives 
information about the program version, copyright, and the company.    Sometimes programmers put 
features in the About screen that are only activated if the user happens on the right combination.



Date and Time Display
The current date and time, according to the system clock, are always displayed to the right of the menu 
selections.    Clicking on either the date or the time display will automatically put the current date or time 
into the appropriate place on the Natal Information Screen.    If you need to correct your system time, 
you do this at Windows Control Panel, Date/Time.    Note that Windows 95/98 can automatically change 
your system clock by one hour in order to make the transition to and from daylight savings time.

If you have set your system clock forward to Daylight Savings Time, you must customize the Time Zone 
under User    Information to be Daylight Time, which is one hour less than the standard hour.



Command Buttons
Activating Command Buttons
Calculate
Quick Display
Clear
Here & Now
Delete
Copy
Cancel



Activating Command Buttons
Command buttons may be activated by three different methods.    You can click on the button with the 
mouse, you can press the speed key combination, or you can tab to the button and then press the space 
bar.    Each button or menu item will have one letter underlined.    Pressing the Alt key plus the underlined 
letter will activate that command button or menu choice.    For example, the Calculate button on the Natal
Information Screen has the letter "l" underlined.    Holding down the Alt key while pressing the "L" key 
will activate the Calculate button.



Calculate
Triggers calculation of a chart once the proper data has been entered into the Natal Information Screen. 

If you have changed any of the information on the Natal Information Screen for a saved chart and then 
click on Calculate, the chart will be calculated with the new data.    You can then save the chart, once it is 
displayed, to the chart file causing the newly configured chart to be saved in place of the old one.    In this 
way, you can update the charts in your file.



Quick Display
Available only after a saved chart has been selected from the chart file.    This button displays the saved 
chart positions without recalculating the chart.    If you have changed the Natal Information of a saved 
chart, or prefer a different house system, zodiac type, or type of moon's nodes from when the chart was 
saved, you should use the Calculate button.    To create a new chart based on the information of the old 
one use the Copy button.

If you have changed any of the information on the Natal Information Screen and then click on Quick 
Display, the Natal Information will be returned to the originally saved information for that chart.



Clear
Clears all entries in the Natal Information Screen.    Click on the Clear button when you are through with 
a previous chart and wish to enter the data for a new person's chart.



Here & Now
Clicking on this button will put the current time, date, latitude, longitude, city, and state/country in the 
Natal Information Screen.    The latter part of this information is what you have entered in the User 
Information screen.    If you then click on Calculate, you will get a chart of the heavens depicting the 
current transiting planets.

If you have set your system clock to Daylight Savings Time, you must customize the Time Zone under 
User    Information to reflect this.    Note that Windows 95/98 can automatically change your system clock
by one hour in order to make the transition to and from daylight savings time.  (For more information, see 
"Entering or Editing the User Information".)



Delete
This selection is unrecoverable.    It will delete the currently shown record from the chart file after 
confirming that you do indeed wish to delete the record.    Unregistered users cannot delete charts from 
the file.



Copy
This selection will copy the data from a selected saved chart.    This is useful if you wish to save more 
than one version of a chart or if your new chart will have many items which are the same as an existing 
saved chart.    You can choose the chart from the Chart List Box, click on Copy, make whatever changes 
you wish, recalculate the chart by clicking on Calculate, and save it to the file.    You will then have two 
versions of the chart in the file.



Cancel
This selection is available only when converting a file or during the selection of a chart to compare to a 
previously displayed chart.    

Related Topics:
During File Conversion
During Chart Comparison



During File Conversion
Clicking on Cancel will cause the conversion to stop after completing the current chart record.    A 
message will then appear telling you after which record the conversion was stopped.    The records 
converted up to that point will be saved in the new file.    For more information on converting chart files 
from one format to another see "File        Convert DOS Chart File" or "File      Convert Windows to DOS 
CHART.AST".



During Chart Comparison
After returning to the Natal Information Screen by way of the File Menu selection Compare This Chart to
Another on the Chart Information Screen, clicking on Cancel will interrupt the comparison process and 
allow you to choose or enter another chart to display without comparing it to the earlier chart.



Overview
The Chart Information Screen displays the graphic chart wheel and a great deal of other information on 
the chart.    It allows you to explore the relationships within a single chart, and those between charts.



The Graphic Chartwheel
Immediately after calculating a chart, Astrology for Windows draws a traditional graphic chart wheel on 
the Chart Information Screen.    The program draws the chart with the planets selected at 
Customization    Planets and in the colors selected at Customization    Chart Colors.    The zodiac and 
house system will be the currently selected ones if you choose Calculate or the systems of the saved 
chart if you choose Quick Display.

The speed with which a chart is calculated and displayed appears to depend most on the speed of your 
graphics display.    Most computers which are able to run Windows can instantly perform the astronomical 
calculations.    If the chartwheel displays too slowly on your machine, consider purchasing a Windows 
graphic accelerator card.

Related Topics:
Aspect Window for Single Planets



Aspect Window for Single Planets
Double clicking on any planetary glyph in the natal chart will list the aspects between that particular planet
and the other displayed planets.    For information on displaying all of the aspects of all the planets in a 
chart or for a list of what aspects are listed see "Display    Aspects List".

Related Topics:
Moving the Aspect Window
Resizing the Aspect Window
Aspect Window Command Buttons



Moving the Aspect Window
The Aspect Window can be moved to any point on the screen by positioning the mouse cursor over the 
caption bar, depressing the left mouse button, and dragging the window to the desired position.



Resizing the Aspect Window
If you wish to change the height of the Aspect Window, position the cursor over either the top or bottom 
border.    The Cursor will change to a double headed arrow.      Press the left mouse button, and drag the 
border to the new size.    The chart inside the window and the command buttons will resize to fit.    If the 
entire list cannot be shown due to the shortened height of the window, a scroll bar will appear, allowing 
you to scroll the list up or down.    Moving and resizing the window allows you to clear the window from 
parts of the chart you may not wish to have covered.



Aspect Window Command Buttons
The Aspect Window has four command buttons which allow you to manipulate the window, and use the 
displayed information.

Select All
Selects all the information so that it will all be copied to the Clipboard.    If you wish to only select part of 
the information to be copied, you can do this by pressing the left mouse button and dragging over the 
items you wish to select.    Selected information is shown as highlighted.

Copy
Copies any selected (highlighted) information to the Clipboard.    Once copied, the information can be 
pasted into any Windows application which allows pasting from the Clipboard such as Microsoft Word for
Windows or Excel.

Print
Prints the entire list of aspects on the installed Windows printer.    It is not necessary to select items when 
printing.

Close
Closes the window.    It is not necessary to close the window to display the aspects of another planet.    
The new planet's aspects will replace those of the previous planet.    The window closes automatically 
when a different display option is chosen or when you return to the Natal Information Screen.



File Menu
The File Menu allows you to save the chart record, save the chart tabular displays to a text file, return to 
the Natal Information Screen, compare the current chart to another, print the current display on your 
printer, change your printer set-up, or exit the program.

Related Topics:
File    Save Chart to File
File    Save Screen as Text File
File    Compare This Chart to Another
File    Return to Natal Info Screen
File    Print
File    Printer Setup
File    Exit Program



File    Save Chart to File
This selection will save the currently displayed chart to the charts.cht file.    For registered users, the file 
will hold approximately 2700 charts, depending on the length of your chart names, as the list box control 
is limited to 65,536 characters.    Once you exceed 2,000 charts, keep track of the size of your charts.ptr 
file, as this is what is loaded into the list box.    AstrolDeluxe ReportWriter, ver. 4, supports up to 32,000 
chart records in a chart file.    Each chart takes up 512 bytes of space in the charts.cht file, so saving 
charts is not likely to cause you to run out of hard disk space.    Do copy your charts.cht file to a 
removable diskette from time to time, as you don't want to lose all of your charts to a hard disk crash 
[read the Windows Help topic "copying files to a floppy disk"].    Unregistered users are limited to one 
hundred charts.



File    Save Screen as Text File
Using this option, you can save whatever tabular report is on the screen to an ASCII text file.    A change 
from earlier versions is that the program will place the complete subject birth data and chart type legend 
at the start of the text file.    This option is not available when a graphic wheel is displayed.

You will be presented with a standard Windows file selection dialog.    The file name chosen should 
consist of a file name of no more than eight letters with an extension of ".txt" or ".doc" (e.g. jdaspect.txt).    
When a tabular report such as the Aspects List or Table of Planets and Houses is displayed, the entire 
table will be saved to the selected file.    It is not necessary to highlight the table before saving to a text 
file.    The resulting file can be edited with a word processing program¾it cannot be accessed by 
Astrology for Windows.    For information on copying a table or graphic wheel to the Clipboard see 
"Copying Charts and Reports to the Clipboard".



File    Compare This Chart to Another
Use this selection to compare another chart to the currently displayed chart by means of a double wheel 
chart.    You will be returned to the Natal Information Screen where you may choose another saved chart
from the Chart List Box or enter new chart information.    The Natal Information menu bar caption will 
change to show that you are in compare mode.    If you wish to cancel the process at this point, click on 
the Cancel Button on the Natal Information Screen.

Once you have the second chart information selected, click on the Calculate Button and a double wheel 
chart will be displayed on the Chart Information Screen showing the first chart on the inside circle and 
the second chart on the outside circle.    The houses will be those of the first chart.    For more information 
on displaying compared chart data see "Display    Synastry".

You can continue to compare the first chart to successive charts as long as you wish.    If you wish to 
return to the Natal Information Screen without doing any other chart comparisons, click on the File    
Return to Natal Info Screen menu selection.



File    Return to Natal Info Screen
Use this selection to return to the Natal Information Screen in order to choose a new chart or to perform 
any of the other functions located there.    Pressing the Escape key on the keyboard or clicking in the 
upper right corner to close the form will also return you to the Natal Information Screen.



File    Print
Use the File    Print menu selection to print whatever data is currently being displayed on the Chart 
Information Screen.

If a graphic wheel is displayed, it will be drawn, at printer resolution, to your Windows selected printer.    If 
tabular data is being displayed, it will be printed in an attractively formatted document.    Both will be 
accompanied by the subject's birth information, the chosen House System, Zodiac, the type of node if you
selected this planet option, and whether it is a day chart or a night chart if you selected the reversed night 
time formula for the Part of Fortune.

Related Topics:
Printing Multiple Copies



Printing Multiple Copies
When you print from the Chart Information Screen, File menu, Print option, you will get a Print Dialog 
box that will show a little Copies box where you can change the number of copies from the default 1 to be 
2 or higher.    The number in the Copies box will only appear in black and be changeable for those printer 
devices such as laser printers that support the multiple copies option.    Most ink-jet and dot matrix printers
do not support multiple copies and so a gray number 1 appears in the Copies box.    The nice thing about 
this Windows feature is that the computer does not take any additional time to generate the extra copy.



File    Printer Setup
Use this option to access a Windows common dialog screen allowing you to change your default printer 
or access your printer's setup driver for more specific print adjustments.    For example, the printer may 
allow printing graphics at different resolutions, which you can adjust when you want to print thicker lines 
on the chart.    As another example, those users with a FAX modem compatible with Windows can select 
their FAX modem as the printer in order to FAX reports or charts to a recipient.

Additional printer adjustments are possible in the Windows Control Panel in the Printers section.    For 
example, if you find that your printer ejects the graphic chartwheel page before all the information is 
printed, go to    Control Panel (for Win3.1 in the Main program group; for Win95/98 in the Settings option 
on the Start menu).    Then double-click on the Printers icon.    Once the Printers window opens,    make 
sure your printer is highlighted.    For Win3.1, click on the button marked Connect....    For Win95/98 click 
on File, Properties, and select Details.    Increase the Transmission Retry to 90.



File    Exit Program
Use this selection to Exit the program.    If there is a new chart on the screen, you will be prompted to 
save it.    If you choose Cancel at this point you can then save the chart.    Otherwise the program will end.



Edit Menu
The Edit Menu allows you to select and copy information to the Windows Clipboard.

Related Topics:
Edit    Select All
Edit    Copy to Clipboard
Edit    Copy Text Report to Clipboard



Edit    Select All
This selection is available when tabular data is displayed.

Although you can select or highlight data to be copied to the Clipboard by pressing the left mouse button 
and dragging across the tabular data displayed on screen, it can be tedious when the table is larger than 
the screen.    This selection allows you to select the entire table at the click of a button.



Edit    Copy to Clipboard
Data copied to the Windows Clipboard can be pasted into any Windows application which has a Paste 
command.    For example, tabular data can be pasted into an Excel spreadsheet or a Microsoft Word for 
Windows document.    The graphic wheels can be pasted into a Microsoft Word for Windows document 
or into Windows Paint in the Accessories group.

Unregistered users can copy only the graphic wheel for the first saved chart to the clipboard.    There is no
restriction on copying tabular data to the clipboard.

Related Topics:
Tabular Information
Graphic Wheel



Tabular Information
After highlighting the data you wish to copy using the mouse or the Edit    Select All menu selection, 
clicking on Copy to Clipboard will copy all highlighted data to the Windows Clipboard.    Depending on 
the nature of the tabular report, the receiving program will treat the data as text or numeric (see the 
discussion "Display    Planet & House Table" or "Tabular Reports".)



Graphic Wheel
There is no need to highlight or select anything when copying a graphic wheel to the clipboard.    When 
the chart wheel or graphic aspects are displayed, clicking on Copy to Clipboard copies the wheel as well
as the subject's natal information, House System name and Zodiac style.    When pasted into a Windows 
application, the Clipboard's contents are treated as a Windows bitmap picture.    Many customers want to 
capture the chartwheel image to a file or transfer it into a word processing document.

The simplest way to copy the graphic wheel to a bitmap or PCX image file is by using Windows 3.1 
Paintbrush or Windows 95 Paint.    Use Astrology for Windows' Edit menu to copy the graphic wheel 
to the Windows clipboard.    Then minimize Astrology for Windows to an icon by clicking on the 
Minimize button at the program's top right corner.    (Find this icon on the desktop or Windows 95/98 
taskbar and restore it when you are ready to return.)    Open up Accessories and Paint and at its View 
menu turn off the Tools and the Palette.    If the white box fills only a portion of the screen, select Options
and Image Attributes and click on Default.    The entire screen should turn white, giving you the largest 
possible area to which to copy.    Click on Edit and Paste.    The graphic wheel will be copied with all detail
to the Paint screen.    You can then select File and Save As... to save it as a bitmap image file.

It is also possible to Paste directly into a word processing document.    The normal procedure is to Insert a
frame of a certain size into the document and then paste into the frame.    The chartwheel may look rough 
on the screen of Word for Windows, but the printed resolution on a laser printer is good even for a size 
of 2 1/2 inches for the entire reduced chartwheel screen.

The resolution of the screen graphic chartwheel will vary with the resolution at which you are running 
Windows.    The chartwheel will be a finer image made up of more pixels if Windows is set to display 
800x600 as opposed to 640x480.



Edit    Copy Text Report to Clipboard
This option will copy not just the grid contents but also the subject's birth information and chart type 
legend to the clipboard.    This can be useful when you are on-line and want to paste someone's complete 
chart information into your e-mail message.



Display Menu
The Display Menu allows you to choose which chart information to display.

Related Topics:
Display    Chart
Display    Graphic Aspects
Display    Aspects List
Display    Supplemental Calculations
Display    Planet & House Table
Display    Synastry
Display    Synastry Transits



Display    Chart
When the Chart Information Screen first appears, the default initial display is to draw the current chart.    
If you have displayed any of the other chart information and you wish to redisplay the chart wheel, click on
Display Chart.    The chart wheel will be redrawn.



Display    Graphic Aspects
To see graphic aspect lines between the planets, click on Display Graphic Aspects.    This will draw the 
chart in the form of a zodiac proportional wheel, with colored lines showing the aspects between the 
planets in the center of the wheel.    Light blue lines indicate the conjunction (0°), trine (120°), and sextile 
(60°) aspects.    Light red lines indicate the opposition (180°), square (90°), semisquare (45°), and 
sesquiquadrate (135°) aspects.    Black lines indicate the inconjunct (150°) aspect (also known as 
quincunx).    Green lines indicate the quintile (72°), biquintile (144°), and semisextile (30°) aspects.    The 
style of line also changes depending on whether the aspects are major or minor aspects.    Solid lines 
indicate the conjunction, opposition, trine, and square aspects.    Dashed lines indicate the sextile, 
semisquare, and sesquiquadrate aspects.    A dash-dot line indicates the inconjunct aspect.    And dotted 
lines indicate the quintile, biquintile, and semisextile aspects.      The program draws the symbols of the 
aspects on top of the lines for all except the conjunction.    A table of these symbols appears in the 
Appendix.    If you want more information about a planet's aspects, double click on its glyph to call up the 
"Aspects of a Single Planet Window".

To see aspects come in and out of focus depending on how exact they are, click on the left and right 
arrows of the Aspect Orb Width scroll bar.    The aspects shown with the orb width set at 100% will be 
those whose orbs are less than the default orb widths given in the aspect table in the next section 
Display    Aspects List.    If you scroll to 20%, the screen will only show aspects whose orbs are 20% or 
less of these default orb widths, and which are thus the most exact aspects in the chart.

Click on the check boxes in the Aspect Types frame in order to eliminate Major or Minor aspects, 
Harmonious or Inharmonious aspects.

If you display the single planet aspect window by double clicking on a planet, the listed aspects will reflect
your current setting of these aspect type check boxes and the orb width scroll bar.    If you change their 
value, then you must double click again on the planet glyph to reset the contents of the aspect window.

Related Topics:
Grid of Aspects, House Cusps, and Planets



Grid of Aspects, House Cusps, and Planets
The triangular grid of aspects between the planets which is traditional for hand-drawn horoscope blanks 
will print beneath the Graphic Aspects Wheel if you select File    Print....    Aspect symbols appear in the 
rows and columns of this grid, allowing you to read up and across to see the planets that are in aspect.    
Two other sets of columns show the exact house cusp positions and planet zodiac positions.    This is the 
only program printout, other than the Planet and House Table in 360° format, which shows the Sun and 
Moon longitudes to the arc-second.    The graphic section of this printout has been kept free of words, 
showing nothing but symbols, for astrologers who are right-brain-oriented and who like to intuitively 
synthesize a chart from astrological symbols only.    For those customers who have color printers, it is also
the most colorful, using your chart circle color selection as the basic foreground color.



Display    Aspects List
To see a tabular, sortable list of all the planetary aspects within the chart, click on Display Aspects.    A 
three column table will appear showing the planetary aspects, the angles between the two subject 
planets, and the orb showing how exact is the aspect.    You can also display the list of aspects of a single 
planet by double clicking on that planet's symbol in the chart wheel.    For more information on displaying 
the aspects of a single planet see "Displaying the Aspects of a Single Planet".

The program uses the following aspects, angles, and default orbs to calculate and print the natal aspects 
between the planets.
Abbr. Aspects Angles Orb of 

Lights
Orb of 
Planets

CJN Conjunction 0 degrees 7 degrees 6 degrees
OPP Opposition 180 degrees 7 degrees 6 degrees
TRI Trine 120 degrees 7 degrees 6 degrees
SQR Square 90 degrees 7 degrees 6 degrees
SXT Sextile 60 degrees 5 degrees 4 degrees
SSQ Semisquare 45 degrees 2 degrees 2 degrees
SES Sesquiquadrate 135 degrees 2 degrees 2 degrees
INC Inconjunct 150 degrees 2 degrees 2 degrees
QTL Quintile 72 degrees 2 degrees 2 degrees
BQT Biquintile 144 degrees 2 degrees 2 degrees
SSX Semisextile 30 degrees 2 degrees 2 degrees

The Orb of Lights is used whenever the sun, moon, or ascendant is one of the aspecting bodies.    The 
Orb of Planets is used whenever the aspect is formed between two other planets.    If you want to be able 
to customize orbs or get more aspects, you should upgrade to the AstrolDeluxe for Windows program.

Related Topics:
Internal Communication Index
Sort by Orbs



Internal Communication Index
The normal range of the Internal Communication Index (ICI) is from 50 to 70, but it can be as low as 25 
and as high as 150.    This is with the default number of planets.    If you add additional planet points by 
customizing the program, then these numbers will increase.    This index is simply the sum of intensities of
all the aspects listed for an individual chart.    A person who has a lot of aspects is going to have more 
communication between the personality functions expressed by the planets than is a person whose 
planets do not aspect each other.    The index may indicate the richness of one's inner experience or the 
complexity of one's personality.

Some believe that people with a very high ICI feel overwhelmed by inputs and feel "crowded" by their 
many planetary aspects.    A high ICI can make it necessary to filter out high-intensity experiences.    This 
is more true if there are a lot of planets in the introverted Earth signs and Water signs than in the 
extroverted Fire signs and Air signs.

People with a low ICI feel more free space in their environments.    They are less likely to feel crowded, 
but they're also less likely to feel motivated or driven.



Sort by Orbs
After you have displayed the aspects for a chart, you have the option of clicking the Sort by Orbs button 
below the list box or of triggering it by pressing Alt-S.    The program will think for awhile and then 
redisplay the aspects with the most exact at the top of the list.



Display    Supplemental Calculations
This selection will display the declinations of the planets up through the Midheaven,    the week day of 
birth, the Julian Day, the sidereal time of birth, and Delta t.

Declinations play an important role in astrodynes calculations.    Astrodynes measure the relative power, 
harmony, and discord of each house, planet, and sign in a person's chart.    Declinations for the planets, 
ascendant, and midheaven are saved with the information for each saved chart.    Halloran Software sells 
a companion program to Astrology for Windows which reads in its saved chart file and calculates a 
chart's astrodynes.    Write for our current price list.

As an aid to astrologers who wish either to check the program's calculations or to recalculate for a 
different dating system or house system, the supplemental calculations screen displays the Julian Day, 
local sidereal time, and Delta t for the current chart.    In regard to the dating system, all dates before 
October 15, 1582 are assumed to be Old Style (Julian Calendar) and all dates after that are assumed to 
be New Style (Gregorian Calendar).



Display    Planet & House Table
This selection lists each of the planets chosen for display and each of the twelve house cusps and their 
positions either in Zodiac sign format or in 360º format.    Clicking on the button below the table will toggle 
back and forth between the two formats.    The 360° format is helpful when you want to see the full 
precision with which the planets have been calculated or when you want to copy purely numerical data to 
a spreadsheet or database for research purposes.



Display    Synastry
This selection is only available when you have displayed two compared charts in a double chart wheel.    
See "Displaying a Double Chart Wheel".

When comparing two charts, the program will list the aspects between the respective planets of the two 
charts.    This is known as synastry.    The program uses the aspects and orbs listed in the table under the 
heading Display    Aspects List.    Favorable aspects between a couple's sun and moon favor friendship, 
between Venus and Mars favor romance, between Mercury and the personal planets favor 
communication, and between Jupiter and a light favor mutual benefit.

Chart compatibility matching which is based upon the technique of chart synastry involves tabulating the 
mutual aspects between two charts.    Each aspect is assigned a positive or negative numerical value 
depending upon which aspect and which planets are involved. These values are displayed on the screen 
next to each aspect; they are summed to arrive at three indexes: a harmonious communication index, an 
inharmonious communication index, and a total communication index.

Related Topics:
The Synastry Weighting System
Sort by Values



The Synastry Weighting System
The Astrology program's synastry weighting system for evaluating chart compatibility has probably 
generated more interest and feedback than any other feature.    In Astrology for Windows, the weighting
is designed to emphasize long-term compatibility rather than just attraction. This helps dating services as 
well as persons considering partners and employees in business.    We improved the weighting system by
working closely with the Stargazers nationwide dating service (1-800-782-7497 and 
http://www.stargazers.com/), who also use techniques not in this program.

The weights depend on a power curve to emphasize mutual aspects that are less than one degree of orb. 
Stargazers recommends using only the 0, 180, 120, 90, 60, and 150 aspects.    As the demo shows, the 
AstrolDeluxe for Windows program uses separate, customizable orbs for synastry comparisons and 
includes a dating service search engine.

Some users have inquired regarding the normal range and significance of the different communication 
indexes.    The range of the Harmonious Communication and Inharmonious Communication Indexes 
between two charts is from about 300 to 6000.    This is for the default planet settings.    Below 1500 is 
low; above 2500 is high. For compatibility, the Harmonious should be high and the Inharmonious low.    A 
Compatibility Index over 1.5 is high and over 2 is very high.

The positive or negative values that the planets and aspects are believed to have for personal 
relationships can be determined by examining the values that print out for each aspect when you choose 
Display Synastry during the Compare This Chart to Another menu selection on the Chart Information 
Screen.    These numerical values have no absolute meaning; they are used to determine the sign and 
amount of an aspect's contribution to the Harmonious and Inharmonious totals. The higher the 
Compatibility Index ratio, the more the relationship is easy and free from friction.    You should look at the 
planetary aspects making up the indexes as you would not want, for example, discordant Saturn aspects 
that could warp or stunt growth (harmonious Saturn aspects promote stability and working out karmic 
problems).

A low Total Communication Index (less than 1800) gives so little communication on the astral plane that 
the two people are like ships passing in the night.    Regarding the total communication, different people 
have different degrees of comfort with closeness or intimacy -- this can affect the level of communication 
or closeness that they should have with their ideal partner.    The idea is that an unaspected Moon or 
difficult aspects to the Moon or Venus could create a personality that finds emotional aspects from others 
to be unfamiliar and possibly uncomfortable.

If you have been burned by relationships in the past, you may only want a perfect relationship, but there is
no such thing.    There are no perfect people who will guarantee that you never experience hurt.    So give 
people a chance if the synastry aspects are encouraging.    After you have done that, follow your heart.



Sort by Values
Click on the button below the list box of synastry aspects or press Alt-S to sort the aspects according to 
how strong they are.



Display    Synastry Transits
If you choose File    Compare This Chart to Another from the Chart Information Screen and make your
second chart a Here & Now chart, then choosing the Display    Synastry option will give you the further 
choice of Transits or Chart Synastry.    To get this additional option, it is not absolutely necessary that 
you click on Here & Now, but the name in the first and last name fields must be "Current Transits" and 
there cannot be an active record in the list box, so if you have retrieved a saved transits chart, gray out 
the list box by clicking the Copy command button.

The Transits option will show you a list of all the aspects formed between chart #2 and chart #1.    Instead
of printing the column of compatibility weights, the Transits option will print a column indicating whether 
the transiting planet is forming an aspect to the natal planet which is Applying (in the future), Separating 
(in the past), or Partile (exact).    Transits affect people most strongly when they are applying and close.

Related Topics:
Sort by Orbs



Sort by Orbs
Click on the button below the list box of transiting aspects or Press Alt-S to sort the aspects according to 
how exact they are.



Astrological Symbols
Astrology for Windows uses traditional symbolic glyphs for the planets and signs.    The following lists 
contain all of the symbols used in the program.

Related Topics:
Zodiac Signs
Planets
Aspects



Zodiac Signs
Sign Symbol
Aries

Taurus

Gemini

Cancer

Leo

Virgo

Libra

Scorpio

Sagittarius

Capricorn

Aquarius

Pisces

Planets
Planet Symbol
Sun

Moon

Mercury

Venus

Mars

Jupiter

Saturn

Uranus

Neptune

Pluto

Part of Fortune

Moon's North Node



Moon's South Node

Chiron

In addition the program uses "A" for the Ascendant, and "M" for the Midheaven, when needed.



Aspects
Aspect Symbol
Conjunction

Opposition

Trine

Square

Sextile

Semisquare

Sesquiquadrate

Inconjunct

Quintile

Biquintile

Semisextile

In Case of Problems
Astrology for Windows is a complex program and, although we at Halloran Software have made every 
effort to eliminate any software bugs or overly complicated procedures, problems may occur.    The 
following is a table of problems that have occurred to a few of our users which seem to be out of our 
control in that they have more to do with the details of particular systems or setups than with the software.
We have suggested some remedies which may prove useful.

Related Topics:



General Problems
Printing Problems



General Problems
Problem Possible Remedy
Will the program have the
year 2000 problem, also 
known as the Y2K 
problem?

Halloran Software programs have always 
used all four digits for the year, so none of 
our programs will have the Y2K problem.    
There would have been a problem with 
Chiron calculating accurately in the 21st 
century, but with version 2.3 of this program 
Chiron is calculated accurately from 1800 
AD to 2100 AD.

My computer gives me an
"Out of memory" 
message.

You should have at least 4MB of memory to 
run the Windows environment.    8MB or 
more is recommended.
Sometimes this message may occur when 
you have depleted the system resources.    
See your Windows manual regarding 
resources.    Close other programs which 
may be running.
Increase the size of your Windows Swap 
File.    See your Windows manual for this 
procedure.

The Atlas maps are not 
displayed on my screen.

On some systems using a graphics card 
capable of producing as many as 65,536 
colors, the maps will not display.    Change 
your system settings to display 16 or 256 
colors.    Do this at Windows 3.1 SetUp or at
Windows 95/98 Start, Settings, Control 
Panel, Display, Settings or see your 
graphics card documentation.

A chart calculated for AM 
shows as PM, although 
the calculations are for 
AM.

In Control Panel, Regional Settings, Time 
Format, the upper box should have AM and 
the lower box should have PM.    If you have
Time set for a 24-hour clock, and a chart 
calculated for 9 AM displays as 21:00 PM, 
you probably have an early version of 
Windows 95.    You can fix this display 
problem by putting blanks in the AM and PM
fields at Control Panel, Regional Settings - 
these are not needed anyway for the 24-
hour clock. 

I get a message such as 
c:\windows\system\ 
grid.vbx is out of date.

Some other program loaded this older 
version into Windows memory earlier during
the current session of Windows.    You can 
prevent it from happening again by copying 
c:\winastro\grid.vbx to c:\windows\system\
grid.vbx (if the file is locked because in use, 
Restart the computer before copying, in 
MS-DOS Mode if necessary).

The program freezes at 
the starry opening screen,
or displaying a graphic 
wheel causes error 480, 
"Can't Create Auto-
Redraw Image."

You have run out of video memory.    Unload
other programs or set-up Windows for fewer
colors or lower resolution.

The program suddenly 
behaves differently than it 
usually does.

Restart Windows.    This will fix about 90% 
of problems.



Printing Problems
Problem Possible Remedy
Although I have a color printer, my 
graphic charts don't print in color.

Go to Customization, Chart 
Colors, and click on the checkbox 
Print in Color.

My printer ejects the graphic 
chartwheel before completing it 
and prints the rest on a 2nd page.

In Windows 3.1 Control Panel or 
Windows 95/98 Settings menu, 
select the Printers icon.    Once 
the Printers window opens,    make 
sure your printer is highlighted.    In
Windows 3.1 click on the button 
marked Connect... or in Windows 
95 select File, Properties, Details.   
Find the Transmission Retry and 
increase it to 90.    Click on Ok, and
then Close.    See your Windows 
manual for more information.

My Hewlett-Packard Deskjet 
1200C printer does not align the 
graphics and text correctly when I 
print the graphic chart wheel.

A problem came up with the driver 
for the Hewlett-Packard Deskjet 
1200C in which it offset every 
graphic element of the chartwheel 
relative to every text element on 
the printed chartwheel.    This 
would cause the degree symbols, 
which are graphic, to print about 
midway in height relative to the 
numbers, which are text, instead of
up at the top of the numbers.    
Hewlett-Packard told the customer 
to substitute the driver for the 
PaintJet XL-400 until they can fix 
the DeskJet 1200C driver.
If you experience any unusual 
printer problem, make sure you 
have the most recent version of the
Windows printer driver for your 
particular printer.    Often, you can 
download the latest printer driver 
from the manufacturer's web site.    
Contact your printer manufacturer 
for details.

 When trying to print, I get a 
message indicating an error 
number in the 28000 series.

This indicates a Windows-level 
printing problem.    Either no default
printer is selected or there is a 
problem with the printer driver that 
is selected.    Try printing from 
Windows Notepad or in Windows 
95/98 go to Control Panel, Fonts, 
select one of the fonts, and try to 
print the font sample to your 
printer.    To use the Windows Print 
Troubleshooting Wizard, at the 
Windows 95/98 desktop, click on 
Start, Help and for the search term 
enter Troubleshooting, Printing 
Problems.    Select it and let the 
wizard walk you through trying 



different things.    If this doesn't 
work for you, contact your printer 
manufacturer to receive a new 
printer driver.

Please check your program directory for a readme.txt file.    If present, it will contain any last minute 
information which came out too late to be included in the manual.    To read this file, view your program 
directory with Win3.1 File Manager or Win95/98 Explorer.    Locate the readme.txt file and double-click on 
it.    The file will be opened in Windows NotePad for your perusal.



Introduction To Astrology
Why does astrology work?    How does astrology work?    To find the answers, it is necessary to step out of
the limited paradigms offered by materialistic science and 19th-century spiritualism.    The following 
paragraphs teach the reader how astrology works from a new perspective that takes the whole spiritual 
universe into account.

Related Topics:
Influences from the Astral Plane
The Sun and Moon Selves
Role of the Planets in the Soul's Learning Process
Incarnating Through the Planetary Stages
The Framework of the Horoscope
Descriptions of the Houses
The Revolution of the Planets
The Signs of the Zodiac
Aspects Between the Planets
Conclusion



Influences from the Astral Plane
Astrology describes the structure of the astral body which is created at birth.    The birth chart describes 
the flow of energy into and out of the astral body.    The soul creates the astral body at the moment of birth
in order to have a link or interface to the physical body.    The energy structure that is created at that time 
is linked to the structure of the geocosmic sphere at that instant.    Different moments in time can see each
other within the astral plane because it is intermediate between this world of space-time and the infinite-
eternal center of being.



The Sun and Moon Selves
Every person has a dominant self and a subordinate self.    Within the astral body the dominant self 
comes from the sun and the subordinate self comes from the moon.    As the center of the solar system, 
the sun is the vital self at the center of the person.    As the earth's cold, reflective, fast-moving satellite, 
the moon is a self of changing moods and reactions to the dominant self and to others.

The sun corresponds to the dominant brain hemisphere, which is usually the left hemisphere.    The left 
hemisphere is the verbal, conscious, unselfish, asexual, and socially cooperative portion of the brain.    
The moon corresponds to the subordinate brain hemisphere, which is usually the right hemisphere.    The 
right hemisphere is the pattern-recognizing, unconscious, selfish, sexually motivated, and socially 
rebellious portion of the brain.



Role of the Planets in the Soul's Learning Process
Whereas the sun and the moon are the outward and inward self-principles within the astral body, the 
planets play more specialized roles.    The planets control stages in the soul's learning process.    These 
stages are: 

1. gathering information; 

2. creating desires; 

3. performing action; 

4. experiencing results; and 

5. analyzing and learning the consequences of one's desires.    

The five visible planets Mercury, Venus, Mars, Jupiter, and Saturn correspond to these stages or functions
within the astral body.    The visible planets govern the conscious self that deals with the external world.    
A similar sequence of stages involving the unconscious self and the internal world appears to begin with 
the invisible planets Uranus, Neptune, and Pluto.    In order for the sequence to be complete, two 
additional planets must exist.

The positions of the planets at the birth of the astral body define the invisible structure of the person not 
because of any gravitational or magnetic influence on the physical plane, but because the creative 
agency that is responsible for souls experiencing life in physical bodies structured the astral plane in this 
manner.    Because the planets correspond to different aspects of life within a body, these 
correspondences make it possible to plan a life starting at a particular time and place in order to work on 
particular life lessons or areas.



Incarnating Through the Planetary Stages
Souls have been progressing through the stages represented by the sun, moon, and planets in 
successive lifetimes.    The historical stages of civilization then mirror the progress of souls through the 
planetary stages.    The sun and moon lifetimes come first and give the soul the opportunity to define the 
characteristic expression of the soul's dominant/outer self and of the soul's subordinate/inner self.    
Because the sun lifetime comes first, the moon lifetime can be a reaction to it, in a subconscious effort by 
the moon self to become its own independent person.

Following the luminary sequence, the first planetary sequence progresses through the visible planets.    It 
therefore focuses on left-brain-type goals and activities.    Different souls are working through the 
planetary stages at different times, but to focus on the initial appearance of the stages within Western 
civilization, we have: 1) the exploration typical of Mercury in the philosophical inquiry of Hellenistic 
civilization; 2) the feelings of Venus in the religious enthusiasm that swept the civilized world around the 
time of Christ; 3) the attempts to implement God's kingdom on earth during the stage of Mars; 4) the 
Jupiterian expansion of the external man and world during the Renaissance; and 5) the scientific 
revolution, puritanical reaction to excesses, and more sophisticated political forms characteristic of 
analytical, controlling Saturn.

The current planetary sequence is progressing through the invisible, newly discovered planets.    It 
therefore focuses on internal or right-brain forces and activities.    The stages of this sequence are: 1) the 
discovery of Uranus in 1781 corresponding to the age of invention and the Age of Enlightenment involving
liberation from the shackles of narrow, left-brain thinking; 2) the inner feelings of Neptune (discovered in 
1846) as expressed in the Romantic movement in art, literature, and music, bohemianism, spiritualism, 
and communal social experiments; 3) attempts to transform the inner person through psychoanalysis, or 
through Prohibition together with the rebellion that followed, in fascist and totalitarian attempts to remake 
both the world and the inner man, and the liberation of atomic energy, all characteristic of Pluto which was
discovered in 1930; 4) the flowering of personal growth and exploration movements which began in the 
1960's, rock and roll which opened up popular music to right-brain emotions, which together with the 
information revolution, marks the stage of the next planet, a planet which expands the inner world in the 
same way that Jupiter and the Renaissance expanded the outer world (in 1977 an astronomer discovered
a small planet orbiting between Saturn and Uranus - Chiron the Centaur); 5) the final stage will be marked
by inner science and holistic science - genetic engineering, fine control of atomic forces, nanotechnology, 
chaos theory, fuzzy logic, understanding of global ecology, knowledge of sociobiological programming, 
use of hypnosis to research the astral plane and past lives, medical understanding of the body's energy 
system, and direct, mystical access to and control of one's brain pathways by the conscious individual.



The Framework of the Horoscope
Astrologers calculate a chart of the sky at the moment of a person's birth in order to see the 
corresponding structure of that individual's astral body.    The base structure of the astral body, into which 
the planets are plugged, is defined by the geographical birth location.    The line between the east and 
west horizon points and the line between the upper and lower meridian points act as lines of energy flow 
within the structure of the astral body.    

The horizon line describes the person and the meridian line describes the environment. Astrologers call 
the point where the eastern horizon intersects the ecliptic the Ascendant.    The Ascendant controls the 
energy flow relating to the private selfhood of the individual.    Its opposite, the Descendant, controls the 
energy flow relating to the individual's public selfhood.    

The lowest point in the sky, the Imum Coeli or lower meridian, describes the type of energy flow relating to
the individual's private environment.    Astrologers call the intersection of the highest point in the sky with 
the ecliptic the Midheaven or upper meridian.    The Midheaven describes the energy flow relating to the 
individual's public environment.

Astrologers divide the sphere of the sky at birth into twelve divisions called houses.    The horizon and 
meridian lines define four quadrants, each of which is trisected by various systems into three houses, 
making a total of twelve houses.    The houses are numbered counterclockwise from the Ascendant at the 
left of the chart, which point marks the cusp or start of the First House.    The Imum Coeli at the bottom of 
the chart marks the cusp of the Fourth House.    The Descendant at the right of the chart marks the cusp 
of the Seventh House.    The Midheaven at the top of the chart marks the cusp of the Tenth House.

The lower hemisphere of the chart, consisting of the six houses below the horizon, deals with the 
individual's private world and inflowing energies.    The upper hemisphere, consisting of the six houses 
above the horizon, deals with the individual's public world and outflowing energies.    The first quadrant of 
each hemisphere relates to the body or self of the person while the second quadrant of each hemisphere 
relates to the environment or society in which the person lives.    The first house of each quadrant relates 
to building the character of that quadrant's focus.    The second house of each quadrant relates to the 
physical structure or support network for that quadrant's focus.    The third house of each quadrant relates 
to motion, activity, or change within that quadrant's focus.    Let us now put all of this together.



Descriptions of the Houses
The First House describes the character of the individual's private self.    This includes the appearance of 
the body and inherent qualities of the self.

The Second House relates to energy flowing into the physical structure of the individual's private self.    
This includes sense impressions, food, possessions and money.

The Third House controls activity within the individual's private self.    The energies of this house relate to 
the native's sources of mental stimulation and personal activities such as thinking, speaking, writing, 
errands, and hobbies.

The Fourth House describes the character of the individual's private environment.    The includes the 
individual's home life and parents, especially the mother.

The Fifth House describes energy flow involving the structure of the individual's private environment.    
This includes the stimulation provided by the individual's friends, social network, offspring, and 
entertainment.

The Sixth House controls activity within the individual's private environment.    The energies of this house 
describe the native's private work, type of employment, and service to others within the native's private 
world.

The Seventh House relates to building the self that the individual presents to the public world.    It 
therefore covers legal definitions of the self such as marriage and partnerships.    It controls the 
individual's characteristic public self-expression.

The Eighth House relates to the physical structure of the individual's public self.    It therefore covers 
buildings and real estate.    It covers energies emanating from the body so it    controls sexual attraction 
and death.

The Ninth House controls activity by the individual's public self.    It covers mental expression and public 
activities such as lecturing, publishing, and traveling.

The Tenth House relates to the character of the individual's public environment.    It describes the 
individual's career and contribution to the world.    During childhood it can describe the father.

The Eleventh House describes energy flow involving the structure of the individual's public environment.    
This includes altruistic, humanitarian social networking by the native.

The Twelfth House controls activity and change within the individual's public environment.    The energies 
of this house describe selfless service to the public, creating work or problems for the self, activities to 
dissolve the self, and solitary retreat.

If a planet is positioned in a house, then that affects the flow of energy through the house.    If the planet is
harmoniously aspected by other planets then the affairs of that house will flow smoothly.    If the planet is 
under stressful aspects then the affairs of that house will be difficult.    A planet in a house by its own 
nature affects the character of the particular life area which the house controls.

The houses defined by the native's birthplace sweep around the 360 degrees of the sky every 23 hours, 
56 minutes.    This is the duration of the sidereal day.    Due to the earth's revolution around the sun, the 
duration of the solar day is 4 minutes longer.    The degree on the eastern horizon at sunrise increments 
by one each day.    The field of the twelve houses in which the planets have what is called their mundane 
or apparent motion is defined to start at the intersection of the observer's eastern horizon with the plane 



of the ecliptic where the sun rises.



The Revolution of the Planets
The plane of the ecliptic in which the planets have their true motion is similarly divided into a field of 
twelve signs which in tropical astrology is defined to start at the point of the vernal equinox, which is the 
ecliptic's ascending node or point of intersection with the plane of the earth's celestial equator.    While the
houses are based on the observer's viewpoint, the signs of the zodiac are geocentric or based on the 
earth's viewpoint.    Unlike the houses, which the planets transit every day, the planets transit the signs 
according to their own rates of revolution.    The revolution periods are as follows: Moon 27.3 days, 
Mercury 87.9 days, Venus 224.7 days, Earth/Sun 365.25 days, Mars 1.88 years, Jupiter 11.9 years, 
Saturn 29.5 years, Chiron 50-51 years, Uranus 84 years, Neptune 164.8 years, and Pluto 248.5 years.

Although the normal motion of the planets is direct, all of the planets (except for the sun and moon) can 
appear to move backward or retrograde relative to the geocentric zodiac of the signs.    This is due to the 
earth's motion around the sun and for the inner planets additionally their own motion around the sun.    
Astrology for Windows indicates planets that are temporarily retrograde by printing the letter R after 
their positions. 

Due to the earth's revolution, the sun moves with direct motion through each sign of the zodiac at 
approximately the same time each year.    The sun position is the basis of sun-sign astrology according to 
which a person considers himself an Aries if he was born from March 21 to April 19, a Taurus from April 
20 to May 20, and so on.



The Signs of the Zodiac
The meaning of the signs is very similar to the meaning of the houses.    One difference is that while the 
planets color the areas of life associated with the houses in which they are located, the signs color the 
planets' expression of their own functions.    While the character of each sign can principally be deduced 
from that of the corresponding house, such as Aries from the first house, astrologers do consider that 
other factors contribute to the character of the twelve zodiac signs.

A factor that can be dispensed with as an influence on the signs is the constellation figure associated with
the sign, such as Ram, Bull, Twins, Crab, Lion, Virgin, Balance Scales, Scorpion, Archer, Goat-Fish, 
Water-Bearer, or Fishes.    These are just what the Sumerians and Babylonians imagined that the stars 
drew in the sky.    Furthermore, due to precession the Babylonian constellations no longer occupy the 
same ecliptic longitudes.    And the sign that the Babylonians always called the "hired man" the Greeks of 
Alexandria, Egypt transformed into a sheep or ram through a scribal misunderstanding.    In Late 
Babylonian times the cuneiform scribes wrote the Sumerian name for Aries, which is lú-hun-gá, in 
abbreviated form by writing just the cuneiform sign lú, which means 'man', but sometimes also the 
homophonic but different sign lu, which, if read as a logogram, means "sheep" (ref: O. Neugebauer, 
Astronomical Cuneiform Texts, vol. II, p. 475, Springer-Verlag publ.).    The Babylonians knew what the 
sign represented, but when the zodiac shows up among the astrologers of Alexandria, Egypt in the wake 
of Alexander the Great's conquests the hired man has become a sheep, as depicted in the late Egyptian 
Zodiac of Denderah.    If the signs can acquire their symbols in such an accidental fashion, then the 
symbols can be no more than mnemonic labels.

A factor which affects the character of the zodiac signs, but not the houses, is that of the element 
triplicities, according to which Aries, Leo, and Sagittarius are Fire signs, Taurus, Virgo, and Capricorn are 
Earth signs, Gemini, Libra, and Aquarius are Air signs, and Cancer, Scorpio, and Pisces are Water signs.  
The elements are related to the doctrine according to which the odd-numbered signs are masculine and 
extroverted while the even-numbered signs are feminine and introverted.    The Fire and Air signs are 
masculine while the Earth and Water signs are feminine.    Signs of the same element and gender are all 
related by harmonious trine or sextile angles, indicating compatible natures.    While both the Fire and Air 
signs are extroverted, the Fire signs tend to be passionate while the Air signs show a mental approach to 
life.    And while both the Earth and Water signs are introverted, the Earth signs tend to have a pragmatic 
approach to life while the Water signs are more sensitive and emotional.

One of the major distinctions between the three signs which make up an element triplicity is whether the 
sign is Cardinal, Fixed, or Mutable.    The modality of the sign relates back to the same distinction that we 
made between the first, second, and third houses of a mundane quadrant.    The four Cardinal signs, 
Aries, Cancer, Libra, and Capricorn, tend to be self-centered builders.    The four Fixed signs, Taurus, Leo,
Scorpio, and Aquarius, tend to be stable, sociable types.    The four Mutable signs, Gemini, Virgo, 
Sagittarius, and Pisces, tend to be restless changers.

Another more problematic factor affecting the signs is that of each sign's ruling planet.    Ptolemy set the 
two luminaries to rule the northern hemisphere summer signs Leo and Cancer because as he says these 
signs are 'most productive of heat and warmth' and Leo is masculine like the sun and Cancer feminine 
like the moon.    He chose distant Saturn to rule the opposite winter signs Capricorn and Aquarius which, 
in the northern hemisphere, are cold and dark like Saturn.    

By placing Mercury as the ruler of the signs Virgo and Gemini on either side of the luminary signs, the 
visible planets Mercury, Venus, Mars, Jupiter, and Saturn ruled two sets of five signs, from Virgo to 



Capricorn and from Gemini to Aquarius.    According to this system, the signs Aries and Scorpio not only 
had the qualities of the first and eighth houses, as well as masculine fire and feminine water qualities, but 
they were also influenced by the nature of the planet Mars.    When the modern planets Uranus, Neptune, 
and Pluto were discovered, astrologers assigned them as co-rulers of Aquarius, Pisces, and Scorpio 
along with the traditional rulers.    It would have made more sense for the invisible planets to replace the 
rulers of Gemini through Aquarius, or at least to be consistent in continuing around the zodiac from 
Aquarius to Gemini.    The haphazard manner in which these new planets have been linked to the signs 
does not say much for the concept of sign rulership in general.



Aspects Between the Planets
Having discussed the character of the planets, houses, and signs, there remains only the character of the 
aspects between the planets to be discussed.    Aspects are specific angles between planets which set up 
communication between the functions of the person which those planets represent.    

The aspect angles recognized in astrology result from dividing the 360 degree circle by whole numbers.    
The fewer the divisions, the stronger the effect of the angle.    The conjunction of 0° results from division of
the circle by 1.    The opposition of 180° results from division of the 360° circle by 2.    The trine of 120° 
results from division by 3.    The square of 90° results from division by 4.    The quintile of 72° and the 
biquintile of 144° result from division by 5.    The sextile of 60° results from division by 6.    The semisquare
of 45° and the sesquiquadrate of 135° result from division by 8.

Because astrologers normally express the planet positions according to    their degree position within the 
signs of 30 degrees each, the aspects of 0°, 180°, 120°, 90°, and 60° are easy to spot visually because 
the degree numbers are the same.    So the sextile has traditionally been emphasized more than the 
quintile and biquintile, which should actually be stronger.    The computer easily calculates and lists 
aspects which are not multiples of 30 degrees.    The traditional emphasis on comparing planets which are
at the same degree position within the 30 degree signs has led to the creation of two other aspects - the 
150° inconjunct (this word originally meant 'not in aspect'; it is also called the quincunx) aspect and the 
30° semisextile aspect.

The hard or discordant aspects are the 180°, 90°, 45°, 135°, and 150° aspects.    The soft or harmonious 
aspects are the 120°, 72°, 144°, 60°, and 30° aspects.    The 0° conjunction is strong for communication 
between the planets involved, but is neither hard nor soft.    The 180° opposition is stressful, but in a 
stimulating and challenging way instead of being warping and difficult like the 90° square.    The 
harmonious 120° trine facilitates the most cooperation between the functions of the two planets.    The 
influence of the 72° quintile and 144° biquintile is similar to that of the harmonious 60° sextile, but it also 
stimulates creativity.    If there is a 150° inconjunct aspect between two planets, then the lack of 
cooperation causes one to overcompensate or try too hard in the areas involved.



Conclusion
The planets, houses, signs, and aspects form the foundation of astrology.    The principal task of astrology
is to understand how their combination in the horoscope at birth has shaped and directed the individual.    
This is called delineating the natal horoscope.    Another important task of astrology is understanding the 
timing and nature of planetary influences upon the individual during the course of a lifetime.    The best 
way to do this is by tracing when the planets overhead move through the houses of the natal horoscope 
and investigating the aspects that these transiting planets make to the planets in the natal chart.    Another
valid application of astrology is to investigate the effect that two people have on each other by seeing how
their charts compare, by seeing what are the aspects between the planets in the two natal charts.    This 
technique, called synastry, is the most popular technique for analyzing astrological compatibility.    There 
are many other astrological procedures, but delineation of the natal chart, daily transits and relationship 
compatibility are fundamental.



Bibliography
Filbey, John; and Filbey, Peter; The Astrologer's Companion.    The Aquarian Press, Wellingborough, 

Northamptonshire, England, 1986.    A technical reference book.

Granite, Robert Hurzt; The Fortunes of Astrology.    ACS Publications, Inc., San Diego, CA, 1980.    
Has good interpretations for the placement of the Part of Fortune.

Hand, Robert; Planets in Transit; Whitford Press, 1976.    Excellent, definitive manual of transit 
interpretations.

Lewi, Grant; Heaven Knows What.    Excellent source for interpreting horoscopes and aspects.

Lewi, Grant; Astrology for the Millions, 1990.    Information on transits and planetary sign positions.

March, Marion D.; and McEvers, Joan;    The Only Way to...Learn Astrology, Volumes I, II, III, The 
Only Way to...Learn About Tomorrow, and The Only Way to...Learn About Relationships.    A 
detailed, modern textbook series on astrology by the teacher co-founders of Aquarius Workshops,
Inc.

Sakoian, Frances; and Acker, Louis; The Astrologer's Handbook.    Good all around introduction for 
the beginning astrologer.

Sakoian, Frances; and Acker, Louis; The Astrology of Human Relationships.    Detailed information on 
synastry and relationships.

The books above are available from the Bodhi Tree bookstore in Los Angeles.    The staff there inform me 
that they can ship books to astrologers worldwide.    Telephone first to determine the price, including 
shipping.    The phone number is 310/659-1733.    The address is Bodhi Tree, 8585 Melrose Ave., West 
Hollywood, CA 90069, U.S.A.    They accept Visa and MasterCard by phone or money orders by mail.    
Say that Halloran Software referred you.



Glossary of Terms
Air Signs
Angular
Apogee
Applying
Arc
Ascendant
Aspect
Asteroid
Biquintile
Biwheel
Bqt.
Cardinal
Chart
Chart List Box
Cjn.
Conjunction
Constellation
Cusp
Declinations
Delineation
Delta Factor
Delta t
Descendant
Dexter aspect
Dynamical Time
Earth Signs
Ecliptic
Elements
Ephemeris Time
Equator
Equinox
Feminine Signs
Fire Signs
Fixed
Geocentric
GMT



Greenwich Mean Time
Greenwich Meridian
Gregorian Calendar
Heliocentric
Hemisphere
Horary Astrology
Horoscope
House
I.C.
Imum Coeli
Inc.
Inconjunct
Inner planets
Intercepted
Julian Calendar
Julian Day
Latitude, Celestial
Latitude, Geographical
Lights
Local Time
Longitude, Celestial
Longitude, Geographical
Lower Hand aspect
Lunar Return
M.C.
Masculine Signs
Mean Time
Midheaven
Modalities
Mutable
Nadir
Natal Chart
Nativity
Nodes
Nutation
Obliquity
Opp.



Opposition
Orb of Lights
Orb of Planets
Outer planets
Part of Fortune
Partile
Perigee
Precession of the Equinoxes
Prime Meridian
Prime Vertical
Qtl.
Quadrants
Quincunx
Quintile
Retrograde
Return Chart
Revolution
Right Ascension
Rising Sign
Rulership
Semisextile
Semisquare
Separating
Ses.
Sesquiquadrate
Sextile
Sidereal Time
Sidereal Zodiac
Sinister aspect
Solar Chart
Solar Return
Solar Revolution
Sqr.
Square
Ssq.
Ssx.
Standard Time



Stellium
Sxt.
Synastry
Syzygy
Time Zone
Transits
Tri.
Trine
Tropical Zodiac
Universal Time
Upper Hand aspect
Water Signs
Zenith
Zodiac



Air Signs
These signs are Gemini, Libra, and Aquarius.    Air sign natives are predominately mental.



Angular
The four angular positions of a chart.    i.e. the Ascendant, Midheaven, Descendant, and Imum Coeli.



Apogee
That point in a satellite's orbit when it is at its greatest distance from the Earth.    See Perigee.



Applying
An aspect between two planets is considered to be applying when one planet approaches the degree 
constituting the aspect.    Applying aspects indicate events in the future.    See Separating and Partile



Arc
Distance as measured along a circle.



Ascendant
The point or degree on the eastern horizon at birth.    The cusp of the first house.    This point determines 
the Rising Sign.    Abbreviated as "Asc."



Aspect
A prescribed angle between two planets.    See Conjunction, Opposition, Trine, Square, Sextile, 
Semisquare, Sesquiquadrate, Inconjunct, Quintile, Biquintile, Semisextile.



Asteroid
One of many small planetary bodies whose orbits lie between those of Mars and Jupiter.    The four major 
asteroids are Ceres, Pallas, Juno, and Vesta.    Chiron, sometimes referred to as an asteroid, is a minor 
planet or comet whose orbit lies between Saturn and Uranus.    



Biquintile
An aspect in which two planets are approximately 144 degrees apart.    A minor creative aspect.



Biwheel
A wheel displaying the planet positions of two separate birth charts within an inner circle and an outer 
circle.    In this program the house cusps are those of the inner chart.



Bqt.
See Biquintile.



Cardinal
A sign mode.    The Cardinal Signs are Aries, Cancer, Libra and Capricorn.    They are associated with the 
cardinal houses (i.e. 1st, 4th, 7th, and 10th).    Natives with many planets in Cardinal Signs tend to be 
producers and creators.    See also Fixed and Mutable.



Chart
Short for birth chart.    A map of the heavens at the time of a person's birth.    Also known as a horoscope.



Chart List Box
On the Natal Information Screen, the list box in the upper right hand corner listing all the chart records in
the loaded file.    Clicking on this box will insert that chart's natal information into the blanks on the Natal 
Information Screen.



Cjn.
See Conjunction.



Conjunction
An Aspect in which two planets are in alignment within a certain orb.    If the Sun is at 28 degrees Gemini, 
and Mars is at 29 degrees Gemini, they are in conjunction with a 1 degree orb.    A conjunction allows the 
energies of the planets involved to work together.



Constellation
Groups of fixed stars existing in a circle outside or beyond the tropical zodiac.    The stars of the ecliptic 
are divided into constellations bearing the same names as the tropical signs, reflecting the time around 
221 A.D. when the tropical and sidereal zodiacs coincided.



Cusp
The beginning or edge of    a house in a chart.    Also the point between zodiacal signs.    Planets near the 
cusp of a house have added significance.



Declinations
The distance of any planet from the celestial equator, either north or south.



Delineation
The analysis, assessment and interpretation of an astrological chart.



Delta Factor
Astrology for Windows allows users of the sidereal zodiac to adjust its starting point by means of an 
offset to the Fagan-Allen sidereal zodiac.    Customers from India usually add 0° W 53' to convert to the 
Lahiri zodiac.    The several other sidereal zodiacs in use have starting points that fall within a range of 
about eight degrees.



Delta t
The difference between Ephemeris Time and Universal Time.    These differences occur because of minor 
fluctuations in the rate of the Earth's rotation.



Descendant
The point or degree on the western horizon at birth.    The cusp of the seventh house.



Dexter aspect
When the aspecting planet is moving away from the planet being aspected in a chart, it is termed a dexter
aspect.    Dexter is from the Latin word meaning right, referring to a right hand aspect.    Astrology for 
Windows uses the term lower hand for dexter aspects, a term derived from Astrology for the Millions by 
Grant Lewi.    See Sinister aspect.



Dynamical Time
A uniform time scale which is defined by the Atomic Clock.



Earth Signs
These signs are Taurus, Virgo, and Capricorn.    Earth sign natives are predominately practical.



Ecliptic
The plane of the solar system in which the planets orbit around the Sun.    From a geocentric point of view,
the apparent path of the Sun through the zodiac.    Measurement on the ecliptic is by longitude, i.e. by 
signs and degrees.



Elements
A category of each of the signs of the zodiac.    See Fire Signs, Earth Signs, Air Signs, and Water Signs.



Ephemeris Time
A uniform time scale based on planetary motion.    Used by the Astronomical Ephemeris from 1960 to 
1983.    In 1984, Ephemeris Time was replaced by a comparable time scale called Dynamical Time.



Equator
The celestial equator is the projection of the Earth's equator upon the celestial sphere.



Equinox
The time when the days and nights are of equal length, which happens twice yearly when the Sun enters 
Aries (vernal equinox) and Libra (autumnal equinox).    The two equinoxes are also the points where the 
celestial equator intersects the plane of the ecliptic.



Feminine Signs
The six even-numbered signs.    In the context of the signs, Feminine denotes sensitive, responsive, and 
reactive.



Fire Signs
These signs are Aries, Leo, and Sagittarius.    Fire sign natives are predominately passionate.



Fixed
A sign mode.    The fixed signs are Taurus, Leo, Scorpio and Aquarius.    Natives with many planets in 
Fixed Signs make their contribution by preserving the established order.    See Cardinal and Mutable.



Geocentric
Astrology for Windows calculates charts from a geocentric point of view, that is having the earth as the 
center of observation.



GMT
See Greenwich Mean Time.



Greenwich Mean Time
The official Time along the Prime Meridian (0° longitude).    All other Time Zones are referenced to 
Greenwich Mean Time (GMT).



Greenwich Meridian
The zero meridian.    The line of longitude which passes through Greenwich, England.    0 º, 0'.



Gregorian Calendar
Our present calendar.    Superseded the Julian calendar as of October 15, 1582, although some countries 
delayed converting to the "New Style" calendar system.    England converted in 1752, making September 
3 become September 14.    Soviet Russia converted in 1918 and Greece converted on March 1, 1923.



Heliocentric
A way of viewing the planets' positions which takes the Sun as the center of observation.    This view is not
supported by Astrology for Windows.



Hemisphere
Half of a sphere or circle.    The horoscope is divided into upper and lower hemispheres by the horizon 
and into eastern and western hemispheres by the meridian.



Horary Astrology
A branch of astrology concerned with answering questions or seeking solutions to problems.



Horoscope
A chart of the heavens at the time and place of a person's birth.    It originally referred just to the 
Ascendant, but has become expanded in usage to refer to a person's astrological fortune.



House
A division of the celestial sphere.    The mundane houses result from dividing the celestial sphere into 
twelve equal segments.    They are identified by giving each a number from one to twelve in an anti 
clockwise direction commencing with the first division below the horizon on the left-hand or eastern side 
of the chart.    The placement of planets in the houses of the birth chart will affect the affairs and flow of 
energies appropriate to each house throughout the course of the native's life. 



I.C.
See Imum Coeli.



Imum Coeli
The lowest point of heaven.    Opposite the Medium Coeli or Midheaven, the Imum Coeli (I.C.) is identical 
with the cusp of the fourth house, except in the Equal House system.



Inc.
See Inconjunct.



Inconjunct
An aspect in which two planets are approximately 150 degrees apart.    A mildly stimulating adverse 
aspect.



Inner planets
Those whose orbits are between the Earth and the Sun, namely Mercury and Venus.    Also called inferior 
planets.    See Outer planets.



Intercepted
A sign is intercepted when it lies between two house cusps without touching either.    This does not occur 
with the Equal House System and occurs mainly in charts calculated for extreme latitudes.



Julian Calendar
This is the European calendar which preceded the Gregorian calendar that we presently use.    The 
program considers dates before October 15, 1582 to be in the Julian calendar.    Births recorded with an 
Old Style date after this date must be converted to New Style before entering them into the program.    
October 5, 1582 in the Julian calendar became October 15, 1582 in the Gregorian calendar.    Through 
February, 1700 A.D. the Gregorian date is the Julian date plus ten.    Through February, 1800 add eleven.  
Through February, 1900 add twelve.    Through February 2100, add thirteen.

Astronomers and historians extrapolate the Julian calendar indefinitely into the past.    However, the 
historian's years 1 B.C. and 2 B.C. equal the astronomer's years 0 and -1 respectively.    The program 
follows the astronomical convention.    The Julian calendar has nothing to do with the Julian Day.



Julian Day
The Julian Day number is an astronomical convention for expressing dates in an unambiguous manner.    
It is a continuous count of days and fractions thereof from the beginning of the year -4712.    The Julian 
Day begins at noon, Greenwich Mean Time.



Latitude, Celestial
The measurement of distance of any planet or star north or south of the ecliptic.    Compare Declinations.



Latitude, Geographical
The degrees and minutes of any place north or south of the Earth's Equator.



Lights
The luminaries¾the sun and moon.



Local Time
See Mean Time.



Longitude, Celestial
The measurement along the ecliptic in terms of signs and degrees from the first point of the zodiac,    0º 0'
0" Aries.



Longitude, Geographical
The degrees and minutes of any place east or west of the Prime Meridian.



Lower Hand aspect
Describes the direction of the transiting planet relative to the natal planet.    If you imagine that the natal 
planet is on the ascendant, then the transiting planet which forms a lower hand aspect will be in the lower 
half of the chart.    See Dexter aspect.



Lunar Return
A chart made for the moment the Moon returns to the exact sign, minute, degree and second of longitude 
that it occupied at the time of the native's birth.



M.C.
Medium Coeli.    See Midheaven.



Masculine Signs
The six odd-numbered zodiacal signs.    In the context of the signs, masculine denotes leadership, self-
expression, and extroversion.



Mean Time
Also called Local Mean Time, Mean Solar Time, Civil Time or True Local Time.    This is the local time for 
the birth longitude.    Standard Time must not be converted to mean time before entering into Astrology 
for Windows because the program uses standard time zones which correspond to standard time at birth. 
The program does allow users to enter a nonstandard time zone, which includes minutes and seconds, in 
order to enter a birth time expressed in the form of local mean time.



Midheaven
The uppermost point in a chart.    Identical with the cusp of the tenth house, except in the Equal House 
system.    Also known as Medium Coeli or M.C.    See Imum Coeli.



Modalities
A category of each of the signs of the Zodiac.    See Cardinal, Fixed, and Mutable.



Mutable
A sign mode.    The mutable signs are Gemini, Virgo, Sagittarius and Pisces.    So called for their flexible 
nature.    Natives with many planets in Mutable Signs tend to be flexible individuals who bring about 
change.    See also Cardinal and Fixed



Nadir
The point opposite the zenith, i.e., the point directly beneath the native's birthplace.



Natal Chart
A graphic depiction of the positions of the planets and house cusps at the time and place of birth.



Nativity
The moment when the astral body is created, linking the soul to the physical body, conventionally the 
instant of drawing the first breath.    Also, the chart made for the moment of birth.



Nodes
The point of the zodiac where a planet crosses out of south into north latitude is called the North Node 
and vice versa.    Astrology for Windows calculates, as a default, the Mean Nodes which astrologers 
have used for centuries.    The True Nodes, which began to be calculated in the 1970's, can be selected at
Customization    Planets.    The motion of the mean nodes is always retrograde.    The true nodes 
sometimes have direct motion.    The Moon's North Node is known as the Dragon's Head and is 
considered to be a beneficent point.    The Dragon's Tail is the opposite point and is considered malefic.



Nutation
A periodic oscillation of the Earth's pole of rotation around its "mean" position.    Nutation must be added 
to a planet's ecliptic longitude to obtain the planet's geocentric apparent position.    The nutation 
component which is perpendicular to the ecliptic must be added to the obliquity between the equator and 
ecliptic.    The nutation in obliquity slightly affects the sidereal time and ecliptic longitude of the chart 
angles.



Obliquity
The obliquity of the ecliptic is the angle between the equator and the ecliptic.    This same angle or tilt of 
the earth's axis relative to its orbit is what causes the four seasons.    As of the year 2000, the mean 
obliquity will be 23° 26' 21.448"    Nutation causes the true obliquity to differ slightly.



Opp.
See Opposition.



Opposition
An Aspect in which two planets are approximately 180 degrees apart.    If Jupiter is at 13 degrees 
Sagittarius, and Venus is at 12 degrees Gemini, they are in opposition with a 1 degree orb.    A challenging
or stimulating adverse aspect.



Orb of Lights
The arc of influence of the Sun, Moon, or Ascendant when aspecting another planet.    It is measured in 
degrees of longitude.



Orb of Planets
The arc of influence of any planet other than the Sun, Moon, or Ascendant when aspecting another 
planet.



Outer planets
Those planets whose orbits lie outside the Earth's orbit, namely Mars, Jupiter, Saturn, Uranus, Neptune 
and Pluto.    Also called Superior Planets.    See Inner planets.



Part of Fortune
Pars Fortunae.    The zodiacal point which is equally distant from the Ascendant as the Moon is from the 
Sun in longitude.    Benefits the house in which it may be located at birth.    One of the Arabian Parts, 
which are sensitive points in the chart that are usually calculated as follows:    Ascendant + Planet X - 
Planet Y = The Part.    The Part of Fortune is not included among the other planets for aspect calculation.



Partile
An aspect between two planets is partile when the angle between the planets corresponds to the exact 
degree and minute which constitutes one of the astrological aspects.    See Applying and Separating.



Perigee
That point in a satellite's orbit when it is nearest the Earth.    See Apogee.



Precession of the Equinoxes
The movement of the equinoctial point 0º Aries which causes the tropical zodiac to pass backward in its 
relation to the constellations at the rate of approximately 50 seconds per year.    Precession is caused by 
the pole of the equator revolving around the pole of the ecliptic in a 25,920 year cycle.



Prime Meridian
0º 0' longitude.    The line of longitude running through Greenwich, England.



Prime Vertical
A great circle passing through the zenith and nadir of the observer and the east and west points of the 
horizon at right angles to the meridian.



Qtl.
See Quintile.



Quadrants
The four quarters of a chart.    The quadrants are numbered in a counterclockwise direction starting from 
the Ascendant.    In Astrology for the Millions, Grant Lewi discussed the transits of planets through the 
quadrants.    He described the first quadrant as the obscure period, the second quadrant as the period of 
first rise (private rise), the third quadrant as the period of second rise (public rise), and the fourth quadrant
as the climax.    



Quincunx
See Inconjunct.



Quintile
An aspect in which two planets are approximately 72 degrees apart.    A slightly favorable aspect like the 
sextile which stimulates creativity.



Retrograde
A backward motion which the planets sometimes appear to have, mainly in consequence of the relative 
position and motion of the Earth.    It is indicated by "R" next to the planet name.    The other conditions of 
a planet are Stationary and Direct.



Return Chart
See Solar Return and Lunar Return.



Revolution
See Solar Return.



Right Ascension
Astronomers measure planetary positions in hours of right ascension along the celestial equator. 
Equatorial right ascension of a planet which has a north or south latitude will differ slightly from its ecliptic 
longitude. 



Rising Sign
The sign of the Ascendant.



Rulership
Each planet has its own sign of rulership, in which its strength is greatest.    The ruling planet lends its 
energy to the character of the sign which it rules.



Semisextile
An aspect in which two planets are approximately 30 degrees apart.    A mildly favorable aspect.



Semisquare
An aspect in which two planets are approximately 45 degrees apart.    A slightly adverse aspect.



Separating
An aspect between two planets is considered to be separating when one planet is moving away from the 
degree constituting the aspect.    Separating aspects indicate events in the past.    See Applying and 
Partile.



Ses.
See Sesquiquadrate.



Sesquiquadrate
An aspect in which two planets are approximately 135 degrees apart.    A minor adverse aspect.



Sextile
An aspect in which two planets are approximately 60 degrees apart.    A favorable aspect.



Sidereal Time
The hour angle of the vernal equinox at a place, i.e. the right ascension of 0º Aries at the birth place.    
When 0º Aries is on the Midheaven then the sidereal time is 0h:0m.



Sidereal Zodiac
The zodiac of the fixed stars or constellations.    The exact starting point of Aries is a matter of 
disagreement.    Used mainly in Indian astrology and by western siderealists who follow the school of Cyril
Fagan and Garth Allen (AKA Donald Bradley).    The ayanamsa or difference between the sidereal zodiac 
and the tropical zodiac is presently about 24°.    See Constellation and Delta Factor.



Sinister aspect
When the swifter planet is approaching a planet slower in motion and forms some aspect it is termed a 
sinister aspect.    Sinister is from the Latin word meaning left, referring to a left hand aspect.    Astrology 
for Windows uses the term upper hand for sinister aspects, a term derived from Astrology for the Millions
by Grant Lewi.    See Dexter aspect.



Solar Chart
This chart substitutes for a chart calculated for a known time of birth.    Taking the Sun's longitude at noon 
on the birthday, the house cusps of a solar chart are at 30° intervals from the solar ascendant (Sun's 
longitude).



Solar Return
A chart made for the moment the Sun returns to the exact sign, minute, degree and second of longitude 
that it occupied at the time of the native's birth.



Solar Revolution
See Solar Return.



Sqr.
See Square.



Square
An aspect in which two planets are approximately 90 degrees apart.    A warping adverse aspect.



Ssq.
See Semisquare.



Ssx.
See Semisextile.



Standard Time
The term employed to designate that all clocks in each time zone register the same time, regardless of 
whether a place is east or west of the center of a zone.



Stellium
A group of planets.



Sxt.
See Sextile.



Synastry
A calculation of the aspects between the planets of two charts.



Syzygy
The nearly straight-line configuration of three celestial bodies (as the Sun, Moon, and Earth during a solar
or lunar eclipse).



Time Zone
Hours and minutes East or West of Greenwich, England.    The earth is divided into 24 Time Zones.    
Each of them is approximately 15 degrees of Longitude in width, although there are numerous local 
variations and anomalies due to political boundaries and local custom.



Transits
The aspects formed by the positions of the planets moving overhead at a specific time with those of the 
Natal Chart.



Tri.
See Trine.



Trine
An aspect in which two planets are approximately 120 degrees apart.    The most harmonious aspect.



Tropical Zodiac
The zodiac used by the vast majority of    western astrologers.    In the tropical zodiac, the equinoctial point
(0º Aries) is identical with the nodal intersection of the celestial equator with the ecliptic.



Universal Time
Based on the rotation of the Earth.    The same as Greenwich Civil Time.    Universal Time is used to 
calculate local hour angles such as the Ascendant and Midheaven.



Upper Hand aspect
Describes the direction of the transiting planet relative to the natal planet.    If you imagine that the natal 
planet is on the ascendant, then the transiting planet which forms an upper hand aspect will be in the 
upper half of the chart.    See Sinister aspect.



Water Signs
These signs are Cancer, Scorpio and Pisces.    Water sign natives are sensitive and emotional.



Zenith
The point directly overhead.    Not to be confused with the Midheaven which is located on the ecliptic.



Zodiac
A belt or ring around the heavens between 15 and 18 degrees wide divided into twelve signs each 
containing 30 degrees of longitude, through which the planets transit, each in an orbit of its own.




